


Di penghujung konser Psycho Circus Tour mereka,
empat personel KISS tersedot ke Umbra, sebuah
dunia dingin yang memenjarakan musik di relung
kegelapan. Dunia yang tertindas oleh sang durjana,
Tempest. NeoProfil mengetengahkan empat sekawan
KISS—Paul, the Concert, Ace, dan Peter yang
berupaya menyelamatkan Umbra dan bumi kita dari
kehancuran.

NeoProfil

KKIISS, YSS, YA!A!

NNeeootteekk  ((NNTT)): Hi, guys. How’s life?
AACCEE: Screw up, if you know what I mean. Can you

imagine when you suddenly plunge into a weird
world that even you yourself don’t know what
exactly is happening.

NNTT: Yeah, what exactly you are experiencing?
PPAAUULL: Itulah yang membuat kami masih bingung.

Saat itu, kami masih di panggung sehabis
memainkan lagu kami. Ttiba-tiba saja—entah dari
mana—ada semacam lidah panjang yang menjulur
dan merenggut kami satu per satu. Selanjutnya
kami sudah berada di dunia yang aneh bin ajaib.
Mereka menyebut planet ini Umbra, dengan
penguasanya yang bengis, Tempest. Yang tidak
kami habis pikir, si Tempest itu bisa-bisanya
melarang orang main musik.

NNTT: Sebagai dedengkot musik kalian pasti protes ya?
CCOONNCCEERRTT: Yes, that’s for sure. There’s no way that

you can ban people from playing their music.
Music’ life. Yeah, guys?

PPAAUULL: Oleh sebab itu, walaupun dengan memperta-
ruhkan nyawa, kami berjuang terus untuk
menghadirkan kembali musik di tanah yang tidak
ramah ini. Dan yang lebih penting, kami berusaha
menyelamatkan bumi dari agenda jahat si Tempest
itu yang katanya mau menghancurkan bumi kita
tercinta. Tapi kalian juga dapat membantu kami,
kok.

NNTT: How?
PPAAUULL: Ikuti webisodes “KISS Immortals” lewat

wwwwww..ddiiggiittaallhhiitt..ccoomm//mmuullttiippaatthh..sshhttmmll. NeoTek
sebarluaskan dong berita ini lewat majalah kalian.

NNTT: Ya, kami memuatnya di NeoGame nomor ini.
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Pendamping Berselancar Salam!Salam!

aaf jika kembali kami
hadir di ruang baca anda
dengan sesuatu yang

baru. Pengembangan memang
tidak pernah hilang dari kamus
kerja kami sehingga lagi-lagi kami
memperbaiki tampilan dan isi
majalah ini untuk anda. Tata letak
yang tampil lebih elegan kami
harap akan membuat anda betah
membaca tuntas majalah ini.

Catatan tambahan pada artikel praktis langkah per
langkah dimaksudkan untuk menambah bobot isi.

Bukan hanya versi cetaknya. NeoTek Online pun kami
ubah agar menjadi lebih bermanfaat untuk anda sehingga
anda tidak cuma membuang pulsa ketika mengunjungi
situs kami. Mulai kini anda dapat men-download isi
majalah NeoTek lewat file format PDF yang kami
sediakan di situs kami. Gratis alias tidak bayar! Mengapa
kami sedemikian jauh melayani anda? Karena kami ingin
komunitas pengguna Internet tumbuh makin subur di
republik ini.

Redaksi
rreeddaakkssii@@nneeootteekk..ccoo..iidd

NeoTNeoTek datang dengan wajah baru.ek datang dengan wajah baru.
Semua itu untuk kenikmatanSemua itu untuk kenikmatan

anda membaca!anda membaca!

MM

KISS berusaha menyelamatkan
bumi dari kehanura.
—NeoProfil

Bagaimana menghubungi NNEEOOTEK?TEK?
KONTRIBUSI ARTIKEL
redaksi@neotek.co.id

SURAT PEMBACA
support@neotek.co.id

WEBMASTER
webmaster@neotek.co.id

PEMASARAN
pemasaran@neotek.co.id

ADMINISTRASI IKLAN
Tel. 021-5481457 Fax. 021-5329041

SIRKULASI NEOTEK
Tel. 021-3854764

ALAMAT REDAKSI
Gedung Cahaya Palmerah Suite 503
Jl. Palmerah Utara III No. 9
Jakarta 11480

NeoTek adalah majalah
penuntun praktis dengan isi
yang ditujukan untuk
membantu anda ketika ber-
Internet ria.

NeoTek menyediakan CD
yang berisi program-
program yang dibahas
pada NeoTek nomor ini:

• SWiSH
• AATools
• Back Orifice
• Listing anti virus makro
• eCatch
• mIRC
+ masih banyak lagi
utilitas yang berguna.

Dapatkan CD-ROM-nya
dalam satu paket dengan
majalah NeoTek:

Majalah + CD Rp22.500
CD saja Rp15.000

Hubungi
Bagian Sirkulasi
Majalah NeoTek
Gedung Cahaya Palmerah
Suite 503
Jl. Palmerah Utara III No. 9
Jakarta 11480

Tel.   (021) 548 1457
Faks. (021) 532 9041

email:
pemasaran@neotek.co.id

Kontak: Elvi R. Nainggolan
MILIS PARA NEOTEKER
http://groups.yahoo.com/group/majalahneotek

www.neotek.co.id
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Daftar Isi

Daftar IsiDaftar Isi
NeoStartNeoStart

NeoTNeoTek Vek Vol. Iol. I I No. 1I No. 1
NeoTNeoTutorutor

NeoEduNeoEdu

NeoTNeoTeknoekno

NeoSearNeoSearchch

NeoStyleNeoStyle

NeoBizNeoBiz

Yang Pertama
Pengalaman pertama
berinternet di warnet

8

KISS Immortals
Multipath game asik dengan
teknologi streaming baru

45

Dasar-dasar HTML
Tutorial membuat frame14

InnerBody.com
Belajar anatomi manusia dan
otomotif di Internet

48

Fitur AutoComplete
pada Internet Explorer12

Multi Email Account
Mengatur penggunaan
beberapa email pada OE

10

Manfaat Internet
Untuk apa saja internet itu?9

Riwayat Hacker
Dari positif menjadi negatif22

Situs yang Ciamik
Rencanakan dulu dengan
matang

42

Masyarakat Hacker
Komunitas bawah tanah26

Hacking Itu Gampang
Pakai saja Back Orifice30

Makro & Trojan Horse
Bagamana memenangkan
duel dengan mereka

32

‘Jenjang Karier’ Hacker
Dari lamer dan script kiddie
sampai elite atau ‘suhu’

28

New Order
Situsnya para hacker29

Agar Canggih Chatting
Lebih jauh dengan mIRC40

eCatch
Satu lagi perangkat untuk
offline browsing

38

Google Lebih Jauh
Masih banyak lagi fungsinya36

Belajar Jadi Hacker?
Coba dulu AATools!25

SWiSH
Menciptakan animasi Flash
tanpa menggunakan Flash

20

Berapa Hit per Hari?
Pasang saja counter!18

Tutorial Frontpage
Membuat frame16
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Daftar Isi

FOKUS BULAN INI

HHaacckkeerr

NeoGameNeoGame

NeoProfil

RealProfil

Situs NeoTek

NeoTek November 2001

Dynamic HTML
Bukan sekedar halaman web
dengan animasi sederhana.

Home Networking
Cara gampang membangun sendiri
jaringan komputer dan Internet
access sharing

Tools untuk Hacking
Teknik mengintai jaringan lawan

Inbox
NeoTeker Menjawab 
NeoTeker. Kutipan 
hasil komunikasi yang 
paling menarik dari 
mailing list NeoTek

NeoRagam
Korban Dotcom
Anggrek Kinclong
Kantor NeoTek di Peta Jakarta

Web Bug Mewabah
Peringatan atau Kabar Bohong?
Call Me HAL

www.neotek.co.id

Jadikan situs NeoTek sebagai pangkalan Anda berselancar

Link Langsung
Kunjungi situs-situs yang dibahas di
majalah NeoTek dengan sekali klik
lewat situs NeoTek.

NeoTek versi PDF
Kehabisan NeoTek di kota Anda?
Dapatkan saja versi PDF-nya. Gratis!

Download
Tersedia juga download di situs
NeoTek selain dari situs aslinya

Layanan Rupa-rupa NeoTek
Dapatkan perlengkapan awal dalam
berinternet dari situs web NeoTek
e-mail address
Alamat e-mail anda di NeoTek.
Menggunakan fasilitas everyone.net
search engine
Cari-cari di situs NeoTek ataupun
keseluruhan Internet. Fasilitas Google
Mailing list
Ini yang paling ramai. Segera ikutan
berbagi pengalaman berinternet!

KISS Immortals
Eksklusif: Saksikan 27 
webisode dari rock band 
legendaris ini sebagai 
pahlawan penyelamat 
bumi manusia.

-1

Kru NeoTek
Bermarkas di
Gedung Cahaya Palmerah 503
Jl. Palmerah Utara III No. 9
Jakarta 11480
Telp. 021-5481457
Fax. 021-5329041

Bank
Bank BNI
a.n. PT NeoTek Maju Mandiri
No. rekening 070.001709720.001

Bank BCA KCP Rawamangun
a.n. Aswan Bakri
No. rekening 0940544131

Pemimpin Umum
Fachri Said

Pemimpin Redaksi
Kosasih Iskandarsjah

Redaktur Ahli
Onno W. Purbo
Michael S. Sunggiardi

Pemimpin Usaha
Fahmi Oemar
Ridwan Fachri

Redaktur Pelaksana
Gianto Widianto
Dadi Pakar

Sekretaris Redaksi
Elvy Risma Nainggolan

Dewan Redaksi
Supriyanto
Ma’mun Abdul Malik

Pemasaran
Hedhi Sabaruddin
Andy Yudiantoro
Tuti Sundari

Sirkulasi
Deddy Ardiansyah
Bangun
M. Ismail

Keuangan
Aswan Bakri
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NeoRagam

Ini Ini && Itu Itu didi InternetInternet Aneka ragam berita singkat sehubungan dengan Internet, terdapat
di Internet, serta teknologi, berita, ataupun gossip di Internet…

WWeb Bug Mewabaheb Bug Mewabah
Si tukang ngintip yang menjengkelkan. Bagaimana mengatasinya?

erencanakan perja-
lanan Anda di kota
Jakarta? Kini terda-
pat peta Jakarta

yang dapat di-zoom sampai
enam tingkat ketelitian di
situs Street Directory.

Mulai di Singapura
Situs ini mulai dengan me-
nyajikan fasilitas peta dan
search engine berdasarkan
peta di  negara asalnya,
Singapura.

Popularistas situs ini me-
ningkat dengan semakin ba-
nyaknya pengendara yang
mencari lokasi dengan  me-
manfaatkan situs ini. Situs
ini memberikan saran perja-

lanan yang terbaik dengan
mobil, bus, MRT, ataupun
berjalan kaki.

Kota-kota Lain
Setelah Singapura, peta se-
rupa disajikan juga untuk
Jakarta, Kuala Lumpur, Bang-
kok, Melbourne, Sydney,
dan Taiwan. Sayang fasili-
tasnya tak selangkap peta
Singapura

Peta untuk Situs Anda
Apabila Anda memerlukan
peta untuk situs Anda sen-
diri, situs ini menyediakan-
nya. Ada biayanya tentu.

MM

Kantor NeoTKantor NeoTek di Pek di Peta Jakareta Jakartata
Streetdirectory.com menyajikan peta kota-kota penting yang dapat di-zoom

PPeringatan atau Kabar Bohong?eringatan atau Kabar Bohong?

Anggrek KinAnggrek Kincclonglong
Lelang oline anggrek kinclong (glowing orchid) pertama di dunia.

•Jl. Palmerah Utara 3, kantor redaksi NeoTek di Jakarta dapat dilihat di
www.streetdirectory.co.id.  Adapun alamat redaksi di Cairnhill Rise, Singapura
dapat dicari di www.streetdirectory.com www.streetdirectory.com

KKoorrbbaann  DDoottccoomm
1,2 milyar Dollar lenyap!

Supermarket web Ameri-
ka, Webvan.com sekarang
ini memegang rekor seba-
gai korban kegagalan dot-
com terbesar, setelah meng-
habiskan uang venture
capital sebesar 1,2 milyar
US Dollar.

Perusahaan ini meminta
perlindungan kebangkrut-
an, namun tampaknya ti-
dak berminat untuk me-
lanjutkan bisnis ini. Dua
ribu orang akan kehilang-
an pekerjaan.

Didirikan tahun 1996 oleh
Louis Borders dari Borders
Books,Webvan nilai saham-
nya pernah melejit men-
jadi 8,7 milyar Dollar se-
waktu pasar modal meng-
gelembung

Ini melebihi boo.com dari
Swedia yang menghangus-
kan 120 juta dollar Mei lalu.

itus web pribadi se-
ring kali ditempat-
kan di web hosting

gratis, seperti AOL atau Geo-
cities, tanpa disadari disadap
siapa saja pengunjungnya dan
informasi ini dikirimkan ke
pihak ketiga yang biasanya
perusahaan riset pemasaran
Internet. Perusahan ini me-
nyiapkan profil statistik pe-
ngunjung situs tersebut.

Teknologi pengumpulan data
dari Internet ini dikenal se-
bagai web bug ataupun isti-
lah lain seperti free gifs dan
web beacons.

Tanpa disadari oleh pemilik
situs web, web bug dipasang-
kan pada situsnya sewaktu
pendaftaran situs itu untuk
hosting. Dengan cara ini
data pengunjung situs priba-

di itu dapat dikumpulkan dan
dibuat statistiknya untuk ke-
pertluan Internet marketing.
Walau demikian, data priba-
di masing-masing pengun-
jung tidak dikumpulkan.

Web hosting gratis biasanya
menempatkan banner iklan
pada pemakai jasanya. De-
ngan mengetahui profil pe-
ngunjung situs web itu, per-
usahaan periklanan dapat
mengatur banner apa yang
cocok untuk ditampilkan.

Yahoo! pemilik Geocities
mengakui menggunakan

web bug, namun tidak me-
nyatakan apakah web bug
itu dipasangkan di situs web
pribadi pelanggannya.

Tingkat pemasangan web bug
meningkat pesat dari 0,5%
situs web pribadi pada tahun
1998 menjadi 18% sekarang
ini. Adapun pada situs web
perusahaan web bug terda-
pat pada 16% di antaranya.

Survei ini dilakukan oleh
Cyveillance di Arlington,
Virginia terhadap satu juta
halaman web.

Bila web bug mengganggu
privacy Anda, gunakan web
bug detector, BUGNOSIS,
untuk mengetahui pengintip
itu dan kirimi dia email.

SS

www.cyveillance.com/web/us/
www.bugnosis.org

ekerja sama dengan
InterAuct!, seorang
dosen NIE (IKIP-

nya Singapura), Dr. Chia
Tett Fat, menyelenggarakan
lelang terhadap anggrek hi-
brida karyanya. Setiap pe-
serta lelang harus menyetor
deposit S$500 dan nilai awal
lelang adalah S$200.00.

Kok semahal itu? Memang
anggrek yang dilelang itu
bukan silangan biasa, tetapi
silangan dengan modifikasi
genetika sehingga anggrek
itu bercahaya dalam gelap.

Untuk menciptakan anggrek
kinclong (bioluminecent or-
chid) ini, Dr. Chia mentrans-
formasi jaringan dari ang-
grek dendrobium dengan
menggunakan gen luciferase
dari kunang-kunang. Dengan
metode yang disebut sebagai
‘particle bombardment,’ DNA

kunang-kunang yang aktif
secara biologis masuk ke ja-
ringan anggrek. Jaringan
yang sudah bertransformasi
ini kemudian diperbanyak
laludigunakan untuk mem-
bentuk tumbuhan transgenik
(tumbuhan yang mengan-
dung gen asing dalam sel-
nya). Proses ini diulang be-
berapa kali sampai sifat bio-
luminasi ini terdapat di se-
mua tanaman transgenik
yang dihasilkan, yang ber-
arti gene gen luciferasi dari

kunang-kunang tadi sudah
sepenuhnya terintegrasi ke
dalam anggrek tadi.

Sejalan dengan upaya Singa-
pura mendorong pengem-
bangan ilmu-ilmu biologi,
Dr. Chia kini membimbing
murid-murid dari 74 seko-
lah dasar di Singapura untuk
belajar menyilang anggrek.
Apabila berhasil, anggrek si-
langan siswa sekolah dasar
itu dapat dinamai sendiri
dan didaftarkan di Royal
Horticultural Society,
London.

Para siswa juga diperkenal-
kan pada bisnis anggrek dan
cara-cara mengkomersialkan
karyanya. Mereka dapat me-
lelang karya mereka lewat
online auction di atas.

BB

www.hybridorchids.com
www.interauct.com

•Tampilan anggrek kinclong dalam
gelap. Tanaman transgenik dengan
gen dari kunang-kunang

CCaallll  MMee  HHAALL
Program komputer
diasuh sebagai balita

Pernah terpikir untuk mem-
besarkan ‘seorang’ anak yang
pada dasarnya adalah suatu
komputer? Itulah yang
sedang dilakukan oleh Anat
Treister-Goren, seorang
neuro-linguist dari Tel Aviv,
Israel.

Nama anak (eh… komputer)
ini adalah HAL dan sedang
belajar berbicara seperti
layaknya anak manusia
biasa. Untuk proyek ambi-
sius ini rancangan HAL jus-
tru sederhana saja. HAL
yang dijalankan pada
Windows 2000 tak lain tak
bukan hanyalah kumpulan
algoritma pembelajaran
yang sederhana.

Namun dari sini diharapkan
akan tercipta suatu kompu-
ter yang mampu mencipta-
kan algoritmanya sendiri
sewaktu bercakap-cakap.

Sebelumnya pernah dicoba
menciptakan program yang
berisi aturan-aturan dasar
bahasa, namun tidak berhasil
karena kurangnya stimulasi
dan pengalaman percakapan.

HAL dirancang untuk mem-
bentuk bahasanya sendiri.
Algirirma yang ada memung-
kinkan HAL meniru pola
yang berbeda-beda dari
karakter teks. Kelebihannya
lagi ada neuro-linguist yang
terus-menerus mengkoreksi
dan memberitahukan yang
benar pada HAL.

Inti algoritma ini adalah hu-
bungan antara pengalaman
komputer sebelumnya de-
ngan kemampuan memper-
kirakan apa yang benar. Sua-
tu metode analisis statistik
dalam menghitung peluang
dalam mengakumulasi pe-
ngetahuan. Suatu bidang da-
lam AI yang sedang hangat-
hangatnya sekarang.

eganasan virus Sir-
Cam, worm yang
berkembang biak

sendiri seperti CodeRed, serta
banyaknya trojan yang
disebarkan oleh para cracker
membuat para pemakai
Internet ekstra hati-hati.

Kehati-hatian ini dapat mem-
buat seseorang menjadi kor-
ban dari kabar bohong (hoax)
mengenai virus.

Tahun ini hoax yang ramai
adalah berita bahwa suatu
virus SULFNBK yang tidak
terdeteksi oleh software anti-
virus. Tentu saja tidak ter-
deteksi sebab SULFNBK.EXE
bukanlah virus, melainkan
file pada Windows yang

mengendalikan nama pan-
jang pada file di Windows.

Kabar bohong lainnya adalah
bahwa file MP3 yang di-
download dari Napster me-
ngandung virus yang dipa-
sangkan pada file MP3 tadi.

Hoaxyang serupa adalah bah-
wa software Microsoft ba-
jakan mengandung virus.

Yang paling tidak masuk akal
adalah hoax bahwa terdapat
virus AOL.EXE yang telah
menginfeksi 30 juta kompu-
ter. Ya ke-30 juta pelanggan
AOL itu!

Bagamana mengenali suatu
peringatan itu benar atau
suatu hoax?

•AAppaakkaahh  bbeerraassaall  ddaarrii
ssuummbbeerr  yyaanngg  ddaappaatt
ddiippeerrccaayyaa??
Bila berasal dari perusahaan
antivirus, kiranya benar.
•AAppaakkaahh  AAnnddaa  ddiimmiinnttaa
mmeennddiissttrriibbuussiikkaannnnyyaa??
Peringatan antivirus tidak
memerlukan distribusi
seperti ini
•AAppaakkaahh  mmeemmaaiinnkkaann
kkeettaakkuuttaann  uummuumm  sseesseeoorraanngg??
Download MP3 mungkin
ilegal. Ini dimanfaatkan
•AAppaakkaahh  wwaakkttuunnyyaa  tteeppaatt??
Virus datang bersamaan.
Apakah ada yang terkena?
•AAppaakkaahh  aaddaa  ddii  ddaattaabbaassee
aannttiivviirruuss??
Update filter antivirus Anda
dari situs web antivirus.

KLIK DI SINI

KLIK DI SINI

KLIK DI SINI

KK
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InboxInbox

Forum ini dimaksudkan sebagai bentuk offline dari mailing list
NeoTek di http://groups.yahoo.com/group/majalahneotek.

NmNNmN
NeoTNeoTeker menjawab NeoTeker menjawab NeoTekereker

Mengenal Telnet
T: Posted July 29
Halo semua. Saya ingin
belajar telnet. Dari mana
saya bisa mendapatkan
sumbernya (download)
yayan@yayanonline.com

J: Posted August 8
Telnet adalah program
untuk masuk ke komputer
lain; caranya
C:> telnet nama-server.com
atau kalau mau masuk ke
port yang spesifik bisa juga
C:> telnet nama-server-
mail.com 25 
akan masuk ke mail server,
port 25; ke POP mail port
110
Onno W. Purbo
onno@indo.net.id

T: Posted August 10
Pak Onno, mengenai telnet
tolong jelaskan secara step
by step cara melakukan
telnet (kalau bisa dengan
contoh yang pernah dila-
kukan oleh bapak). Dan
alamat-alamat yang bisa
dengan bebas kita dapat
lakukan telnet.
Dadan Ramdhan
fre_ly@hotmail.com

J: Posted August 12
step-nya ya
nyalain komputer-nya
sambungin ke internet
masuk aja ke DOS
ketik 
telnet nama-mesin
dah itu sih sih
kalau mau agak main-main
telnet nama-mesin nomor-
port
misalnya
telnet smtp.indo.net.id 25
nanti akan masuk ke mail

server Indonet ..
buat ngirim mail pakai
SMTP ..
Onno W. Purbo
onno@indo.net.id

T: Posted August 12
Terima kasih atas jawaban-
nya Pak Onno. Namun
masih ada beberapa hal
yang membingungkan:
1. Tolong betulkan

pemahaman saya tentang
telnet, yaitu apakah
benar dengan melakukan
telnet saya bisa mengak-
ses komputer (menelu-
suri database, ambil atau
kirim file, dll)  dari kom-
puter di seberang sana,
sehingga saya bisa men-
dapatkan segala infor-
masi yang terdapat dari
komputer tersebut. Apa-
kah seakan-akan mirip
jika saya melakukan ftp
dengan wsftp pro (mi-
salnya) pada komputer di
seberang. Jika hampir
sama (antara telnet dan
ftp) dimana letak perbe-
daannya, dan apa kele-
bihan masing-masing.

2. Apakah ada universitas
atau sejenisnya yang

memberikan akses untuk
melakukan telnet tanpa
harus menjadi member
atau ijin khusus, jika ada
tolong berikan alamatnya.

3. Saya pernah mencoba
mensetting smtp dan pop3
untuk mengirim dan me-
nerima mail lewat OE,
untuk account mailcity
yaitu smtp -->
smtp.mail.mailcity.com
dan pop3 -->
pop.mail.mailcity.com,
ternyata tidak bisa me-
ngirim atau menerima
mail, dimana letak
kesalahannya.

Terima kasih sebelumnya,
punteun agak panjang
pertanyaannya.
Dadan Ramdhan
fre_ly@hotmail.com

J: Posted August 12
1.Kalau mau menelusuri

database ya mungkin
kudu ngarti SQL aja dan
tahu port mana yang
kebuka buat database tsb.
Cuma mabok juga kali ya
kalau query database
secara manual pakai
telnet

2.Ini namanya shell

KomentarKomentar

accoun.t. Engga tahu
siapa yang mau ngasi
gratisan :) ..
Paling gampang sih bikin
aja shell sendiri pakai
Linux di mesin sendiri :)

3.Saya check host
smtp.mail.mailcity.com
& pop.mail.mailcity.com
engga ada tu .. yakin
mesin-nya ada?

Onno W. Purbo
onno@indo.net.id

Komputer restart sendiri
T: Posted July 30
Haloo semua
Gimana cara agar kompu-
ter saya tidak lagi merestart
sendiri? Soalnya seringkali
komputer saya merestart
sendiri tanpa ada peringat-
an terlebih dahulu, ini
terjadi berulang-ulang kali,
biasanya terjadi tiap 15-30
menit waktu komputer
sedang dipergunakan, ada
kalanya sampai 1 jam baru
kompie merestart sendiri.
apakah karena adanya pro-
gram yang konflik atau
karena masalah dari
hardware komputer saya?
Donny Mongkareng
La_Nny@neotek.everyone1.net

J1: Posted August 2
Sepertinya komputernya
kepanasan coba tambah
kipasnya atau mungkin
coba komputernya dinya-
lakan dengan kondisi
cashing terbuka. Kalo
ternyata tidak ada masalah
mungkin processornya
yang kepanasan. Solusinya
harus ganti kipas atau
mungkin tambah kipasnya.
Skinner
step2k@telkom.net

J2: Posted August 6
1.Mungkin aja, ada yang

salah pada setting pro-
pertis-nya, bisa dicoba
tuh ganti setting-nya..

2.Format ulang hd trus
isntall lagi pake software
asli biar sistem-nya fres
lagi

2.ganti kipas prosesor-nya.
selamat mencoba...!!!

oji@ekilat.com

Flash & IE
T: Posted August 6
Saya baru belajar buat web
nih. Saya pake dream-
weaver 3, flash 5, adobe
photo 6, ie 5. Yang jadi
masalah. Flash di dream-
weaver tidak mau keluar,
juga jpg-nya. Itu saya tes
di On-line & off line sama
tuh. Trus cara utk ganti
icon jpg/gif/bmp biar tam-
pil gimana? Soalnya saya
pernah pake netscape 6
mungkin berhasil, tapi ma-
lah nggak tuh. Icon file
gambar juga berubah jadi
icon window. Site saya
www.geocities.com/ijoe_id
tolongin saya ya. apa yg
salah. ciao.
Joko Imansyah
ijoe_id@yahoo.com

J: Posted August 8
Coba cek site yang di
dreamweaver cocok tidak
direktorinya dengan direk-
tori gambar dan flash.
Alamsyah
alamsyah@liverpoolsupport
er.com

Hosting
T: Posted August 17
Saya sudah bisa mendapat-
kan hosting di Tripod.lycos.
com dan website yang saya
sudah rancang di Microsoft

Front page sudah selesai.
Di majalah neotek Januari
2001 diharuskan download
cuteFTP yang gratis untuk
menempatkan website tsb.
Saya tidak menemukan
cuteFTP yang gratis di
Lycos. Saya mencoba
download di Download.com
tapi harus beli. Selain itu
juga saya mencoba lang-
sung klik publish di micro-
soft Front Page namun
gagal. Saya mohon
bimbingan. Terima kasih.
Rahyussalim
rahyussalim@yahoo.com

T: Posted August 17
Saya sudah memiliki CD
ROM majalah neotek vol
1-6 dan sudah mendown-
load cuteFTP problemnya
diakhir setting di suruh
masukkan no kode atau
beli  atau lanjutkan. Apa
yang seharusnya kita pilih? 
Kemudian Saya coba me-
milih lanjutkan kelihatan-
nya saya berhasil namun 
ketika saya mencoba up-
load ke tripod lama sekali
sampai saya menunggu 
kurang lebih 2 jam namun
belum berhasil. Mohon
saran pemecahannya.
Terima kasih banyak
Rahyussalim
rahyussalim@yahoo.com

J: Posted August 17
CuteFTP ini adalah trial
version yang berlaku 30
hari. Yang dipilih adalah
'lanjutkan' dan akan dapat
dipakai selama 30 hari.
Ada juga FTP client lain

yang cukup baik dan benar-
benar gratis (freeware). Pe-
riksa saja di antaranya di
www.indo.net.id (pilih
'Koleksi Software' lalu
'FTP Client'.
Kalau mau lihat 'koleksi'
yang lebih lengkap tentang
segala macam sofware (ter-
masuk FTP client) lihat
www.tucows.com
redaksi@neotek.co.id

T: Posted August 18
Saya sudah beberapa kali
meng upload Web yang
sudah saya disain dengan
menggunakan microsoft
FrontPage melalui cuteFTP.
Kelihatannya tidak ada
masalah. Namun bila saya
buka url yang diberikan
tripod ke saya ternyata
tidak muncul. Kenapa ya?
Apakah file microsoft
Frontpage tidak bisa di-
upload dengan mengguna-
kan cuteftp. Mohon
penjelasan.
Rahyussalim
rahyussalim@yahoo.com

J: Posted August 18
ctrl+a di kolom kanan,
pastikan direktori yang
mau diupload udah bener,
trus klik icon anak panak
ke atas di toolbar cute
perhatikan dikolom bawah
kalo sdg ditransfer ada
keterangan tranferring,
kalo ok musti ada tulisan
namafile STOR dan ada
tanda succeded, kalo blh
tahu url nya?
Ijoe
ijoe_id@yahoo.com

• Utilitas untuk Internet disediakan hampir di semua situs ISP. Gambar
di atas adalah halaman yang menyediakan koleksi FTP Client dari ISP
lokal, Indo.net (www.indo.net.id/ftp.html)

• Informasi dasar mengenai Telnet dapat dijumpai di Internet, seperti
di Internet Basics (www.usd.edu/trio/tut/start/telnet.shtml yang
membahas Telnet untuk para pemula.

Setelah membaca Opini Pak
Onno W. Purbo di salah satu
Tabloid Internet tentang keti-
daksetujuan dibentuknya
Dept. TELEMATIKA, setelah
saya pikir-pikir saya setuju
banget karena seumpama
saja Dept. tersebut dibentuk
hanya akan menguntung-
kan beberapa pihak saja
terutama yang gede-gede
dan cenderung tidak win-
win untuk pihak lain serta
trust masyarakat Indonesia
tentang kemajuan TI di In-
donesia boleh jadi berku-
rang karena mungkin saja
proyek KKN kambuh lagi.

Tetapi mengingat komunitas
TI di Indonesia banyak sekali,
ada yg Independen dan pro-
fesional (MIS atau IT di per-
usahaan) mungkin saja me-
nurut saya perlu dilakukan
pendekatan khususnya
perencanaan perkembangan
TI ke depannya.

Kalo saja TI di Indonesia hen-
dak maju ke depan sudah
selayaknya Dept. TELEMATI-
KA tidak dibentuk hanya sa-
ja yang penting implemen-
tasinya dari beberapa Profe-
sional dan Independen bisa
saling mengadakan kerja
sama yang win-win dan sa-
ling trust... lah...! Kalo diben-
tuk Dept. TELEMATIKA  mung-
kin banyak sekali regulasi
tertulis yang mesti dijalani
oleh beberapa pihak yang
ingin mengembangkan TI di
Indonesia seperti E-UKM, re-
gulasi seperti RUU Teleko-
munikasi dan RUU HAKI.

Itu semua kan zamannya
Gus Dur yang boleh dikata-
kan belum berjalan, bisa di-
buktikan dengan banyaknya
protes tentang pembentuk-
an Deppen yang gagal.

Itu menurut Opini saya lho
sebagai salah satu rakyat ke-
cil yang peduli tentang per-
kembangan TI di Indonesia.

Terima Kasih
Foryanto J. Wiguna
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Ada Apa Saja di IntAda Apa Saja di Internet (dan di Situs NeoTernet (dan di Situs NeoTek?)ek?)

Untuk Apa SajaUntuk Apa Saja Internet Internet Itu?Itu?
Selain untuk browsing, Internet juga menyajikan banyak fungsi untuk
berkomunikasi, riset, dan rekreasi. Beberapa fungsi yang lazim dapat
diperoleh pada situs web NeoTek…

itus NeoTek ber-
kembang dari ba-
hasan mengenai

hal-hal yang ada di Internet.
Setelah setahun berkiprah
sebagai majalah cetak, situs
yang berfungsi sebagai eta-
lase berbagai hal yang ada
di Internet itu menjadi suatu
contoh yang baik untuk para

pemula mengenal apa saja
fungsi dan yang dapat
diperoleh di Internet.

Situs NeoTek memang tam-
pak sederhana sebab me-
mang dibuat berdasarkan
teknik-teknik yang dibahas
dalam majalahnya. Teknik-
teknik yang dapat diikuti
oleh siapapun yang bermi-

nat. Tidak diperlukan penge-
tahuan dasar yang cangih-
canggih untuk mengikuti
bahasan di NeoTek.

Bukan berarti NeoTek hanya
untuk pemula. Topik yang
dibahas dapat cukup canggih
dan menarik bahkan untuk
yang sudah berpengalaman
berkiprah di dunia Internet.

E-mail
Salah satu fungsi
yang paling jelas
manfaatnya adalah
e-mail (electronic

mail) yang memungkinkan
kita berkorespondensi de-
ngan siapapun di seluruh
dunia tanpa tergantung
pada lambatnya pelayanan
pos (snail mail). Dapatkan
web e-mail address Anda
dari NeoTek. Alamat Anda
akan berupa sebagai berikut:
nama@neotek.every1.net

Mailing List
Setelah punya ala-
mat e-mail, ikuti
komunitas maya
pembaca NeoTek

(dikenal sebagai NeoTeker)
dan dapatkan manfaat de-
ngan berbagi pengetahuan
Anda dengan anggota lain.
Anggota milis ini mulai
dari pemula sampai pakar
Internet, Onno W. Purbo.
Tidak perlu malu bila Anda
masih sangat awam. Sia-
papun dapat berkontribusi! 

Chat
Ngobrol di Internet
atau chatting ada-
lah salah satu kegi-
atan gaul anak muda

jaman sekarang. Anda bisa
ngobrol langsung dengan
siapa saja di mana saja di
seluruh dunia melalui fasi-
litas chat di Internet. Ngob-
rolnya masih lewat keyboard.
Sebenarnya chat yang lebih
populer bukan melalui web,
melainkan dengan software
khusus: mIRC atau ICQ.

Hiburan dan Bisnis
Dengan semakin
cepatnya akses ke
Internet, terutama
dengan semakin

terjangkaunya koneksi
broadband, Internet sema-
kin nyaman untuk menyam-
paikan hiburan. Hiburan di
internet dapat berupa online
game, video (download
ataupun streaming), audio
(misalnya MP3), dan
online game. Dalam bisnis
berupa e-commerce.

S
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Search Engine
Internet selain un-
tuk berkomunikasi
(alat gaul), berguna
juga untuk mencari

informasi. Untuk mencari
informasi di Internet diper-
lukan yang namanya search
engine. NeoTek menempat-
kan Google, search engine
yang sangat populer dan
efektif di situs webnya.

4

5

PPerertama tama MengenalMengenal InternetInternet
Dimana Anda pertama kali mengenal Internet? Kebanyakan orang sekarang mengenal Internet
lewat warnet (warung internet) sebelum kemudian terhubung sendiri ke Internet di rumah atau
kantor

Mengenal BroMengenal Browserwser

eberapa komputer
di warnet biasanya
terhubung secara

bersama-sama ke Internet
(connection sharing). Inilah
yang memungkinkan biaya
koneksi ke Internet di war-
net dapat ekonomis diban-
dingkan dengan satu kom-
puter menggunakan satu
koneksi.

Koneksi di Rumah
Agar suatu komputer dapat
terhubung ke Internet di-
perlukan saluran telepon
dan modem. Saluran tele-
pon hanya dapat membawa
data analog, sedangkan
komputer memproses data
digital. Modem mengkon-
versi sinyal yang keluardan
masuk dari/ke komputer
agar dapat dibawa oleh
saluran telepon.

Saluran telepon biasa yang
sering juga disebut sebagai

POTS (plain old telephone
system) yang biasa ada di
rumah-rumah dapat digu-
nakan untuk akses Internet.
Walaupun murah, kecepat-
annya jarang yang melebihi
56 kbyte/detik.

Telepon Broadband
Kini terdapat pilihan salur-
an telepon yang lebih cepat,
yaitu ISDN dan ADSL yang
umumnya berkecepatan
128 dan 300 kbyte/detik.
Saluran ini disebut telepon
broadband.

Apabila ISDN mempunyai
kecepatan masuk dan keluar
yang sama cepatnya, maka
pada ADSL kecepatan yang
disebut itu hanyalah untuk
masuk (download), sedang-
kan keluar (upload) sama
dengan kecepatan telepon
biasa. ADSL adalah singkat-
an dari Asymetric Data Sub-
scriber Line

Broadband yang Lain
ADSL adalah jawaban per-
usahaan telepon terhadap
tawaran akses Internet bu-
kan melalui saluran tele-
pon, melainkan mengguna-
kan televisi kabel (cable mo-
dem). Saluran televisi kabel
yang masih banyak lowong
itu ditawarkan untuk akses
Internet.

Apabila menggunakan cable
modem, maka akses Inter-
net tidak melalui dial-up
networking, melainkan kom-
puter Anda merupakan ba-
gian dari jaringan luas dari
perusahaan televisi kabel itu.

Connection Sharing
Di kantor atau warnet, bia-
sanya beberapa komputer
terhubung secara bersama-
sama menggunakan satu
atau lebih saluran ke Inter-
net. Beberapa komputer itu
biasanya membentuk suatu

jaringan (network) atau
menggunakan perangkat
untuk connection sharing.

Yang digunakan bersama-
sama itu dapat satu atau be-
berapa saluran telepon yang
digabung untuk banyak
komputer, atau dapat juga
beberapa komputer berbagi
satu akses cable modem.

Apa Perlu ISP
Apabila menggunakan sa-
luran telepon, baik yang
biasa,ISDN, ataupun ADSL,
akses Internet memerlukan
ISP (Internet Service Pro-
vider) yang berfungsi seba-
gai gerbang masuk ke Inter-
net. Anda perlu mendaftar
ke ISP, kecuali ke TelkomNet
yang mengutip biaya konek-
si Internet dari pulsa tele-
ponnya. Apabila menggu-
nakan cable modem, ISP
tidak diperlukan.

B

TTerhubung kerhubung ke Internet: Bagaimana Caranya?e Internet: Bagaimana Caranya?

ertama kali Anda
berada di warnet,
tepatnya di depan

komputer yang terhubung
ke Internet, tampilan yang
Anda lihat adalah tampilan
perangkat lunak yang ter-
pasang di komputer itu
yang namanya browser.
Sesuai dengan namanya,
browser digunakan untuk
melihat-lihat (browsing)
Internet atau istilah lain-
nya adalah berselancar di
Internet (surfing the Net).
Terdapat berbagai macam
browser, tetapi yang paling
banyak digunakan adalah
Internet Explorer dan
Nescape Navigator. Gam-
bar di sebelah kiri adalah
layar Internet Explorer
yang menampilkan
halaman kosong (blank).

P
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kantor yang berbeda ISP dengan
account email di rumah tetapi anda
ingin keduanya dapat diatur dalam
satu manajemen email. Untuk itu-
lah diperlukan satu program email
client yang dapat melakukannya.
Dengan OE, pengaturan ini dapat
dilakukan dengan mudah.

Apa yang harus dilakukan
Sebelum anda melakukannya, ada
beberapa informasi yang harus anda
ketahui. Informasi tersebut adalah
alamat email, account name, pass-
word, nama POP server dan SMTP
server dari masing-masing ISP

tempat anda berlangganan. Selan-
jutnya silakan ikuti tutorial di
bawah ini.

nda dapat menyetel
Outlook Express (OE)
untuk menangani lebih dari

satu account email yang anda
punyai. Account email yang kami
maksudkan disini adalah POP based
email yang biasanya didapat dari
Internet Service Provider (ISP) jika
anda berlangganan. Saat ini sema-
kin banyak orang yang berlang-
ganan lebih dari satu ISP agar jika
salah satu ISP down, maka dapat
digunakan ISP yang lain.

Kombinasi kantor dan rumah

Sebagai contoh, pada saat di kantor
anda menggunakan account email di

MMEENNGGAATTUUR PR PEENNGGGGUUNANAANAN
BBEEBBEERRAPAPA EA EMAIMAIL PL PADADAA
OOUTLUTLOOOOK EXK EXPPRRESSESS
Aturlah agar pesan-pesan email untuk urusan bisnis, pribadi dan
kemasyarakatan terpisah agar email anda terkelola. Dengan
Outlook Express semua itu dapat dilakukan.

A

Pengisian Data Selesai
Bila muncul window seperti di atas,
berarti anda telah menyelesaikan satu
account email baru. Bila anda ingin
membuat account lagi, ulangi lagi
langkah-langkah ini dari 1-6 karena OE
mampu menghandel account email
lebih dari satu. Kemudian klik Finish

Set as Default
Hal yang perlu diperhatikan adalah
account email mana yang ingin anda
jadikan sebagai default-nya. Anda bisa
mengubahnya dengan mengklik salah
satu ikon account tersebut lalu klik Set
as Default. Selanjtunya klik Properties.

Ketikkan nama anda
Pertama kali digunakan, Outlook
Express akan memuncul Internet
Connection Wizard untuk mengatur
konfigurasi email anda. Tuliskan nama
yang ingin ditampilkan pada kolom
From pada saat orang lain menerima
email anda. Lalu klik Next.

Masukkan alamat email anda
Selanjutnya masukkan alamat email
yang didapatkan dari ISP langganan
anda, lalu klik Next.

1

5 6

2

Pilih koneksi

Pada Properties, klik tab Connection. Anda
boleh memilih jenis koneksi yang diingin-
kan atau dikosongkan saja sehingga
account email anda akan terkoneksi
menggunakan default koneksi yang ada.
Selanjutnya klik Apply lalu OK.

Mengirim dan menerima email
Bila anda ingin mengirim atau meneri-
ma email dari salah satu account, klik
toolbar Send/Recv. Lalu pilih dan klik
salah satu nama account tersebut
(misal:Redaksi). Maka OE akan segera
mengirim dan menerima email hanya
dari account itu.

Nama-nama server email
Sebelum Outlook Express dapat
mengirim dan menerima email dengan
account ini, diperlukan nama-nama
server email ISP anda. Server-server ini
adalah tempat menyimpan email yang
masuk dan keluar. POP server untuk
yang masuk dan SMTP untuk keluar.

Account name dan password
Isikan nama account dan password
yang anda peroleh dari ISP pada kotak
Account Name dan Password.
Selanjutnya klik Next

3

7 8

4

Internet Service
Provider Sebuah
perusahaan penyelenggara
jasa Internet seperti CBN atau  Indonet yang
menawarkan jasa koneksi ke Internet melalui
komputer dan sebuah modem. ISP anda akan
memberikan informasi teknis yang diperlukan
untuk menyetel komputer anda.

Account Email Termasuk di dalamnya
adalah alamat email, user name, password,
nama server POP dan SMTP serta besarnya
tempat penyimpanan pesan email masuk
yang disediakan oleh ISP.  

DDAFAFTTARAR
IISSTTIILLAHAH

MMARARI KI KITITAA
CCOOBA!BA!

TIP & TRIK • TIP & TRIK  • TIP & TRI  

Pengelolaan Pesan
Email yang masuk dari beberapa
account akan diletakkan dalam

folder Inbox bersamaan, sehingga
diperlukan suatu pengaturan email
yang benar. Gunakan fasilitas Mail
Rules yang pernah dibahas di NeoTek
Vol. I, No. 7, April 2001.

!

Multiple Internet Accounts?
Jika anda berlangganan lebih dari
satu ISP, tidak jadi masalah jika

salah satu sedang down. Segera
alihkan ke ISP yang lain dan account
email anda masih bisa digunakan.

!

Cara menyetel multiple account email dengan Outlook Express

APA YANG
ANDA DAPAT?

Bagaimana mengatur
lebih dari satu account
email dalam Outlook
Express, dan bagaimana
caranya mengirim dan
menerima email dari
semua account yang
anda punya.

SEBERAPA
SULIT?

Setting account-acount
email tambahan adalah
mudah begitu anda
mempraktekan langkah
1-5 pada tutorial ini.
Selain itu anda harus
mempunyai informasi
account email dari ISP
langganan anda.

APA GUNANYA?
Anda mungkin
mempunyai lebih dari
satu alamat email misal
satu di rumah dan satu
lagi di kantor. Dengan
menyetel multiple email
dari OE ini, akan anda
rasakan kenyamanannya.

FORWARD KE
DIRI SENDIRI1

Hal ini berguna untuk
anda yang mempunyai
account email di rumah
dan di kantor yang
berbeda. Hanya dengan
mengaktifkan Forwad,
account email akan selalu
dapat dimonitor.

HOTMAIL2
Hotmail (www.hotmail.
com) adalah layanan web
based email yang po-puler.
Pesan email disimpan di
web dan dilihat dengan
menggunakan browser
daripada anda harus men-
download-nya.

WORKING
OFFLINE3

Untuk menghemat biaya
pulsa telepon yang sema-
kin menggila, tulislah pe-
san anda secara offline
dimana koneksi Internet
harus diputus dulu. Sete-
lah selesai, baru online
dan segera klik Send.

MEMBUKA IE
DARI OE4

Untuk mecari informasi di
Web melalui OE (Outlook
Express), klik menu Help.
Lalu arahkan ke  Micro-
soft on the Web, dan klik
Search the Web untuk
mencari situs web yang
diinginkan.
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Web, formulir, atau kata sandi
(password) yang pernah anda ma-
sukkan sehingga anda tidak perlu
selalu mengetikkan kembali infor-
masi tersebut saat lain kali anda
akan menggunakannya kembali.

Bagaimana Cara Kerjanya?
Fitur AutoComplete menyimpan
(save) alamat Web, formulir, dan
kata sandi yang pernah anda ketik-
kan. Dengan demikian, pada saat
anda mengetikkan informasi pada
salah satu field ini, AutoComplete
akan memberitahukan anda bentuk
yang paling mendekati dari apa

yang tengah anda ketikkan itu.

Jika anda merasa apa yang disodor-
kan IE sesuai dengan yang anda
maksudkan, anda tinggal menekan
tombol Enter.

nda dapat menyetel Inter-
net Explorer (IE) agar lebih
sesuai dengan keinginan

anda ketika mem-browse halaman-
halaman Web.

Pengaturan itu dapat anda lakukan
lewat berbagai fitur yang disediakan
oleh Internet Exporer yang me-
mang kaya akan fasilitas itu.

Fitur AutoComplete
Salah satu fitur yang berguna ada-
lah yang bernama AutoComplete.
Dengan mengaktifkan fitur ini anda
seakan memerintahkan IE untuk
mengingat atau menyimpan alamat

FFIITTUUR AUR AUTTOOCOCOMMPPLELETTEE
PPADADAA
IINTENTERRNNEET EXT EXPPLLOORREERR
Fitur AutoComplete pada Internet Explorer dapat membantu
anda untuk bekerja lebih efisien. Anda tidak perlu lagi
mengulang-ulang memasukkan informasi tertentu di Internet
Explorer yang kaya akan fasilitas itu.

A

Meng-iya-kan ‘AutoComplete’
Jika setuju dengan saran yang diajukan
IE, anda cuma perlu menekan tombol
panah ke bawah satu kali, dan setelah
sampai pada alamat Web yang anda
tuju, tekan tombol ‘Enter.’ Anda pun
memperoleh alamat tersebut tanpa
harus mengetikkan seluruhnya.

Riwayatmu Dulu
Anda dapat melihat ‘riwayat’ browsing
anda yang telah terekam lewat fitur
auto-complete pada IE. Untuk itu, tekan
tombol ‘History’ pada Toolbar.

Menu ‘Tools’
Buka Internet Explorer (IE) anda, lalu
klik menu ‘Tools’ pada Toolbar.
Selanjutnya pilih menu ‘Internet
Options.’

Fitur ‘AutoComplete’
Pada window kecil yang muncul, pilih
tab ‘Content.’ Di bawah ‘Content’ akan
muncul bagian ‘Personal information.’
dengan salah satu pilihannya—
’AutoComplete.’ Tekan tombol
‘AutoComplete’ tersebut.

1

5 6

2

Catatan Bersejarah
Pada sisi kiri layar IE akan muncul
sebuah kotak dengan nama ‘History’
yang berisi catatan situs atau halaman
Web mana saja yang anda kunjungi
selama beberapa waktu, misal: last
week, Monday, Tuesday, atau Today.

Menghapus jejak
Anda dapat menghapus apa yang telah
di-save oleh ‘AutoComplete.’ Untuk itu
anda perlu kembali ke menu ‘Tools’>
‘Internet Options.’ Pada window yang
terbuka, klik tab ‘General.’ Lalu pada
bagian ‘History’, klik tombol ‘Clear
History.’ Jejak browsing anda pun sirna.

Penyetelan ‘AutoComplete’
Kembali muncul sebuah window kecil—
AutoComplete Settings—yang mena-
warkan anda data apa saja yang anda
inginkan agar disimpan otomatis oleh
IE. Item yang anda pilih harus diklik
sehingga muncul tanda cek pada kotak
di depan item bersangkutan. Klik ‘OK.’

‘AutoComplete’ dalam praktik
Kini, jika mengetikkan suatu informasi
yang pernah anda masukkan, seperti
alamat Web pada contoh di atas, fitur
‘AutoComplete’ pada IE akan memberi
‘saran’ pada mengenai kemungkinan
terdekat dari informasi tersebut.

3

7 8

4

Feature Bagian yang
menonjol pada suatu
perangkat lunak. Salah satu
tantangan aplikasi modern adalah
kemampuan untuk menawarkan berbagai
macam fitur tanpa membuat aplikasi itu
menjadi rumit.

Browse Melihat dan meninjau data atau in-
formasi di Internet, terutama di World Wide Web.

Password Sederetan karakter yang harus
anda masukkan untuk memperoleh akses
pada suatu bagian sistem komputer. 

DDAFAFTTARAR
IISSTTIILLAHAH

MMARARI KI KITITAA
CCOOBA!BA!

TIP & TRIK •TIP & TRIK •TIP & TRI

Biarkan IE yang menghapal
Dengan mengaktifkan fitur Auto-
Complete anda tidak perlu meng-

hapal semua alamat situs yang pernah
anda kunjungi karena IE yang akan
‘menghapalkannya’ untuk anda.

!

Bisa juga lewat ‘History’
Alamat situs bisa juga anda telu-
suri lewat menu ‘History’ dengan

menekan tombol ‘History’ pada
Toolbar IE (lihat Langkah7) atau
menekan Ctrl+H.

!

Menggunakan fitur AutoComplete

MENGAPA AUTO
COMPLETE??

Auto complete dapat
membantu anda mem-
percepat kerja di IE
karena dengan hanya
beberapa ketikan, alamat
yang sudah terekam akan
muncul secara otomatis.

DAPATKAH DIAK-
SES SITUS WEB??

IE meng-enkripsi informa-
si yang direkamnya  lewat
auto-complete sehingga
privasi anda terlindung.
Situs Web atau pemakai
Internet di situs lain tidak
dapat mengakses data
yang anda masukkan
pada formulir, misalnya.

APAKAH DAPAT
DIPILIH??

Anda dapat memerintah-
kan IE untuk hanya
merekam alamat Web,
formulir atau password
(lihat Langkah 3).

GUNAKAN
‘HISTORY’1

Jika auto-complete tidak
menemukan alamat situs
yang pernah anda kun-
jungi, silakan mencoba
menu ‘History’ (lihat
Langkah 6 dan 7.)

MENGHAPUS
REKAMAN2

Anda dapat menghapus
item yang direkam IE le-
wat auto-complete pada
suatu formulir. Untuk itu,
sorot (highlight) teks atau
item dimaksud lalu tekan
tombol ‘Delete.’

TOMBOL PINTAS3
* Alt+Home: ke Home-

page
* Alt+Panah kanan: ke

halaman berikutnya
* Alt+Panah kiri: ke

halaman sebelumnya
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membuat 2 frame vertikal yang sa-
ling berhubungan dan satu frame
horizontal yang independen.

Langkah 1-6 menjelaskan pembuat-
an dokumen HTML yang saling
berhubungan untuk ditampilkan
dalam frame. Hal yang perlu diper-
hatikan di sini adalah ppeennaammaaaann
mmaassiinngg--mmaassiinngg  ffrraammee  iinnddiivviidduuaall
dari frame vertikal ini.

Pada dua langkah selanjutnya—
Langkah 7-8—diterangkan cara me-
link dokumen-dokumen HTML ke
frame-frame individual tersebut
sehingga frame-frame tersebut akan
saling berhubungan.

eperti yang telah dijelaskan
pada nomor lalu bahwa do-
kumen HTML yang berisi

ffrraammee  ddeeffiinniittiioonn tidak mendeskrip-
sikan isi setiap frame. Isi dokumen
HTML setiap frame diindikasikan
oleh atribut SRC dari <FRAME>
yang berisi teks, gambar dan kode
HTML yang ditampilkan oleh
frameset.

Agar halaman Web yang berbasis
frame ini dapat bekerja, anda harus
membuat dokumen-dokumen
HTML yang saling berhubungan
untuk ditempatkan dalam frame
yang berbeda. Pada tutorial ini kami

DDAASSARAR-D-DAASSAR HAR HTTMMLL
DDALALAM 8 LAM 8 LANANGGKKAH: AH: 
MMEEMMBBUAUAT FT FRRAMAMEE
Setelah anda mengikuti tutorial tentang dasar-dasar frame pada
dua nomor terdahulu, sekarang kita lanjutkan ke bagian cara
penamaan frame dan membuat hyperlink antar frame.

S

Membuat htmlfooter.htm
Selanjutnya buat dokumen
htmlfooter.htm untuk mengisi frame
paling bawah (horisontal). Tulis kode di
atas dan simpan sebagai htmlfooter.htm.

Preview dengan browser
Seperti biasa, klik file HTML yang baru
anda buat dan tes dengan browser
apakah kode yang anda tulis sudah
benar atau belum.

Membuat ‘htmlconfr.htm’
Buka Notepad dan tuliskan kode-kode
HTML seperti di atas lalu save sebagai
htmlconfr.htm Perhatikan baris 9, 11
dan 13 berisi: #document_tags,
#heading_tags dan #paragraph_tags.
Ini berarti link ke bagian frasa tertentu
pada suatu halaman Web.

Preview dengan browser
Jalankan browser dan buka file
htmlconfr.htm . Tampak 4 link yang
dibuat dengan kode HTML yang berbeda.
Chapter 5 merujuk pada seluruh do-
kumen  05notesfr.htm sedangkan yang
lain merujuk pada bagian tertentu dari
dokumen 05notesfr.htm

1

5 6

2

Dokumen Frame Definition
Tulislah kode di atas untuk membuat
dokumen HTML yang berisi frame defin-
ition. Kode ini menjelaskan pembagian
frame, link dokumen HTML ke dalam
frame dan penamaan frame masing-
masing. Lalu save sebagai htmlfr.htm 

Preview dengan browser
Sekarang anda telah berhasil merang-
kai beberapa dokumen HTML ke dalam
satu dokumen berbasis frame. Klik file
htmlfr.htm dan browser akan menam-
pilkannya sebagai satu halaman Web
yang terdiri dari 2 frame vertikal dan 1
frame horizontal. 

Membuat ‘05notesfr.htm’
Tulis kode-kode HTML di atas dan save
sebagai 05notesfr.htm. Perhatikan tag:
<A NAME=”document_tags”>Document Tags </A>
Ini bukan link tetapi target link. Dokumen lain
yang ingin me-link ke target ini harus menam-
bahkan tanda “#” sebelum nama target dan
sesudah nama dokumen seperti Langkah 1.

Preview dengan browser
Sekarang buka file 05notefr.htm dengan
browser. Tampak di sini frasa-frasa yang
kita buat untuk target link (Document
tags, Heading tags). Jadi pada saat doku-
men lain me-link ke frasa tersebut, maka
browser akan menaikkan frase itu ke
posisi paling atas dari layar. 

3

7 8

4

Frame Tag pada HTML
untuk membagi area pada
browser menjadi beberapa
bagian (frames). Isi setiap frame berasal dari
dokumen HTML yang berbeda. Frame mem-
berikan fleksibilitas dalam perancangan hala-
man Web.

Frame Definition Struktur kode HTML
yang  mendeskripsikan bentuk tampilan suatu
halaman Web yang berbasis frame.

Individual Frame Frame yang ada
pada suatu halaman web.

Vertical Frame Frame yang terbagi
secara vertikal pada suatu halaman web.

Horizontal Frame Frame yang terba-
gi secara horizontal pada suatu halaman
Web.

DDAFAFTTARAR
IISSTTIILLAHAH

KKOODDE-KE-KOODDEE
HTMHTMLL

TIP & TRIK •TIP & TRIK •TIP & TRI

Cek, cek, cek!
Lakukan pengecekan setiap anda
selesai membuat tag atau kode

HTML dengan browser anda. Dengan
demikian anda menjadi tahu perbe-
daan setiap tag yang anda tulis.

!

Penamaan dokumen
Buatlah selalu penamaan doku-
men HTML anda dengan memakai

huruf kecil karena hal ini akan memu-
dahkan anda untuk bekerja dengan
Web server tertentu.

!

Penamaan frame dan link dokumen ke frame

APAKAH
NOTEPAD ITU?

Notepad adalah program
text editor dari Microsoft
Windows yang paling se-
derhana dan biasanya di-
gunakan secara default
untuk menangani penu-
lisan script program se-
perti HTML ini.

Untuk menjalankannya,
klik Start/Programs/
Accessories/Notepad

HTM ATAU HTML?
Untuk menamakan suatu
dokumen HTML yang an-
da tulis di Notepad, ketik
nama file yang diinginkan
pada kolom File name.
Anda boleh memberikan
ekstensi dengan htm atau
html. Kedua ekstensi ini
akan dibaca browser se-
bagai dokumen HTML.
Terserah mana yang anda
pilih.

<FRAMESET ROWS>1
<FRAMESET ROWS=”*,80”>
Membagi suatu halaman
Web menjadi 2 bagian se-
cara horizontal dengan
komposisi: bagian bawah
tingginya 80 piksel dan
sisanya dialokasikan untuk
bagian atas.

<FRAMESET COLS>2
<FRAMESET COLS=”30%,*”>
Membagi halaman Web
menjadi 2 bagian secara
vertikal dengan komposisi:
bagian kiri mempunyai
lebar 30% dari seluruh
halaman sedangkan ba-
gian kanan merupakan
sisanya—berarti 70% dari
lebar seluruh halaman.

<FRAME SRC>3
<FRAME SRC=”dok.html”>
Memasukkan suatu doku-
men HTML yang bernama
dok.html ke dalam suatu
frame.

NAME=NAMA
FRAME4

<FRAME SRC=”dok.html”
NAME=”Chapter”>
Kode ini akan membuat
browser memasukkan
dok.html ke dalam frame
yang diberi nama Chapter.

BAGAIMANA
CARA SAVE AS?

Untuk menyimpan doku-
men HTML yang telah di-
buat, klik File/Save As.
Setelah menamakan doku-
men HTML yang telah di-
buat dengan memakai
ekstensi HTM atau HTML,
selanjutnya pilih All files
(*.*) pada kolom Save as
Type. 

Lalu pada kotak Save in
cari lokasi atau folder un-
tuk menyimpan file terse-
but. Selanjutnya klik tom-
bol Save.
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Penggunaan bookmark diperlukan
jika kita ingin melihat bagian-
bagian atau paragraf tertentu dari
sebuah dokumen HTML dan biasa-
nya dokumen ini berisi suatu uraian
yang panjang. Caranya dijelaskan
pada Langkah 5.

Setelah bookmark dibuat, kami juga
jelaskan cara me-link ke bookmark
tersebut dari dokumen HTML yang
lain. Dalam hal ini, dokumen yang
berisi bookmark (frame dengan na-
ma bbaabb55) berada pada frame yang
berbeda dengan dokumen lain
(ddaaffttiissii). Semuanya dijelaskan pada
Langkah 6.

Langkah 7 dan 8 adalah bagian yang
paling mudah yaitu cara menyim-
pan dan mengecek hasilnya dengan
browser apakah bookmark dan link
yang kita buat bekerja dengan baik
atau tidak.

enggunaan Microsoft
FrontPage 2000 untuk
membuat dokumen HTML

yang berbasis frame, akan sangat
mempermudah anda. Hal ini akan
terbukti jika anda mempraktekkan
tutorial ini.

Jika pada nomor lalu kita telah ber-
kenalan dengan dasar pembuatan
frame, sekarang kita lanjutkan de-
ngan penamaan frame, penggunaan
bookmark dan membuat link antar
frame. Pembuatan dokumen dalam
frame dijelaskan padaLangkah 1-2
dan penamaan tiap frame pada
Langkah 3-4.

DDAASSARAR-D-DAASSAR FAR FRROONNTTPPAAGGEE
DDALALAM 8 LAM 8 LANANGGKKAH: AH: 
MMEEMMBBUAUAT FT FRRAMAMEE
Seperti pada tutorial HTML, kali ini kita menggunakan FrontPage
2000 sebagai program editor untuk mengikuti tutorial tentang
cara penamaan frame, penggunaan bookmark dan membuat
hyperlink antar frame.

P

Membuat Bookmark 
Bookmark dipakai untuk me-link bagian
atau paragraf dari suatu halaman web.
Sorot bagian kalimat/kata, lalu klik menu
Insert>Bookmark. Pada window Book-
mark, ketikkan nama bookmark yang
anda inginkan dalam kolom Bookmark
name lalu klik OK. Pada contoh ini, kami
beri nama Documnet_tags. 

Bookmark dan link antar Frame
Untuk membuat link ke bookmark, sorot
kata yang akan di-link lalu klik Insert
>Hyperlink. Pada kolom URL dari win-
dow Hyperlink, ketik nama dokumen
HTML lalu pilih nama bookmark tujuan
pada bagian Optional. Untuk link antar
frame, ketikkan nama frame pada kolom
Target frame. Lalu klik OK.

Menjalankan FrontPage
Buka FrontPage dan klik menu File>
New>Page. Kemudian pada window
New, klik FramesPages dan pilih Ver-
tical Split. Selanjutnya akan muncul
window seperti di atas yang terdiri dari
2 frame vertikal. Klik tombol New Page
di salah satu frame.

Ketik teks untuk setiap frame
Dengan FrontPage, anda bisa langsung
mengetikkan isi setiap dokumen HTML
yang anda buat. Kami sengaja menge-
tikkan isi yang sama dengan dokumen
pada tutorial HTML pada halaman
sebelumnya agar kita bisa merasakan
kemudahannya.

1

5 6

2

Save As dalam satu folder
Sekarang simpan file itu dengan meng-
klik menu File>Save As dan pilih lokasi
folder lalu klik tombol Save. Maka 3
buah dokumen akan disimpan oleh
FrontPage yaitu: dokumen untuk
frame daftisi, bab5 dan dokumen
untuk Frame Definition (index1.htm). 

Preview dengan browser
Untuk mencek hasilnya, klik file
index1.htm dan browser akan me-
nampilkannya sebagai satu halaman
Web yang terdiri dari 2 frame vertikal.
Jika anda klik salah satu link di frame
kiri, maka hasilnya akan ditampilkan di
frame kanan.

Memberi nama frame sebelah kiri
Selanjutnya namakan setiap frame. Un-
tuk itu, klik frame yang sebelah kiri lalu
klik tombol mouse kanan dan pilih
Frame Properties. Pada window Frame
Properties, ketik nama frame pada ko-
lom Name, misalnya: daftisi. Lalu klik
tombol OK.

Memberi nama frame sebelah
kanan
Lakukan hal yang sama untuk frame
sebelah kanan. Pada contoh ini kami
beri nama: bab5. Lalu klik tombol OK. 

3
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4

Bookmark Penandaan
bagian atau paragraf tertentu
dari suatu halaman Web. Pada
kode HTML, dibuat dengan atribut NAME dari
elemen anchor <A> dengan bentuk tag-nya
adalah: <A NAME=”nama paragraf”>

Frame Properties Sub-menu pada
FrontPage yang digunakan untuk mengedit
bagian yang berhubungan dengan frame
seperti nama frame, ukuran frame, dan
sumber dokumen setiap frame.

DDAFAFTTARAR
IISSTTIILLAHAH

MMARARI I KKITITAA
CCOOBA!BA!

TIP & TRIK •TIP & TRIK •TIP & TRI

Mengubah ukuran frame
Pada FrontPage 2000, anda
bisa dengan mudah meng-

ubah ukuran setiap frame dengan
menggeser-geser batas frame
dengan mouse.

!

Frame yang tetap
Untuk membuat frame yang anda
buat tidak bisa diubah-ubah oleh

pengguna browser, un-check pilihan
Resizable in Browsers pada menu
Options di window Frame Properties.

!

Penamaan frame, penggunaan bookmark dan link antar frame

MICROSOFT
FRONTPAGE ATAU
FRONTPAGE
EXPRESS

?

Keduanya adalah produk
Microsoft. Microsoft Front-
Page mempunyai menu
lebih lebih lengkap diban-
ding FrontPage Express.
Yang kami pakai adalah
Microsoft FrontPage 2000
yang merupakan bagian
dari Microsoft Office 2000.

HTML  ATAU
WYSIWYG
EDITOR

?

HTML editor atau kadang
disebut juga Tag editor
adalah program untuk
mempermudah pembuat-
an dokumen HTML dimana
pengguna masih berhu-
bungan langsung dengan
kode-kode HTML secara
detail.

Sedangkan WYSIWYG
(What You See Is What You
Get) editor adalah program
untuk membuat dokumen
HTML dengan cara lang-
sung mengetikkan isi doku-
men tanpa harus mengeta-
hui dan memahami kode
HTML secara rinci. Jadi apa
yang anda tulis akan sama
dengan apa yang dihasilkan
oleh program editor ini.

Contoh HTML editor adalah
HotDog sedangkan
WYSIWYG editor adalah
FrontPage, Dreamweaver.

Mengirim email dari
Microsoft FrontPage!

Setelah anda berhasil
membuat suatu halaman
Web dengan Microsoft
FrontPage 2000, lalu anda
ingin memberitahu teman
anda hasilnya. Bagaimana
caranya? Gampang!

Pada FrontPage, klik menu
File>Send

dan window New Message
dari Outlook Express
segera muncul dengan file
halaman Web anda akan
di-attach secara otomatis. 

Anda tinggal mengeikkan
alamat email, pesan email
lalu dial-up modem dan
setelah masuk ke Internet,
klik Send. Maka halaman
Web anda dikirim ke rekan
anda.
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ounter adalah program peng-
hitung. Yang dihitung ada-
lah banyaknya suatu situs

atau halaman Web dikunjungi oleh
para netter di dunia maya. Counter
juga mampu mendekteksi jenis
browser yang dipakai oleh para netter,
sistem operasi, domain, resolusi layar
dan juga kedalaman warna. Semua
itu dirangkum dalam suatu statistik
yang mudah dibaca. Hal ini tentu sa-
ngat diperlukan bila kita ingin me-
ngembangkan situs yang kita buat
ke tahap yang lebih profesional. Untuk
lebih jelasnya, ikuti tutorial berikut
ini.

BBEERRAPAPAA HHIIT PT PEER HARR HARI?I?
PPAASSANANG SG SAAJJAA
COCOUUNNTTEER!R!
Jika anda ingin mengetahui berapa hit situs anda diklik orang,
anda harus memasang program counter di situs anda. Cara
yang paling mudah adalah dengan membuat link ke situs yang
khusus menyediakan fasilitas ini. Salah satunya adalah situs
TThheeCCoouunntteerr yang beralamat di www.thecounter.com

C

Upload dan tes 
Kemudian upload file HTML yang
telah anda ubah ke server situs
anda. Selanjutnya tes dengan meng-
klik alamat situs itu dan lihat hasil-
nya. Kalau anda masuk ke situs
NeoTek, maka anda akan melihat
tampilan counter pada bagian
bawah halaman depan.

Mengubah tampilan counter
Untuk mengubah tampilan
counter, anda harus kembali ke
halaman sebelumnya dan klik link
‘Log in and configure your Counter.’

Membuat akun
Pada window ini, klik tombol
‘CREATE ACCOUNT’ untuk
mendapatkan akun (account)
anda.

Akun anda
Sekarang akun anda telah
diberikan oleh situs ini. Akun ini
diperlukan pada saat anda login
kembali untuk melihat hasil sta-
tistik atau mengubah opsi lain-
nya. Untuk melihat counter code,
klik link ‘Click here.’

4
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5

Konfigurasi
Kalau kunjungan anda ke situs
milik anda tidak ingin dihitung,
klik ‘Don’t count me,’ sebaliknya
klik ‘Count me.’ Untuk jenis me-
tode counter, anda bisa pilih ‘All
hits’ atau ‘Only unique.’

Tampilan Counter
Jika anda ingin mengubah tam-
pilan Counter, cari menu ‘Con-
fig’ lalu klik ‘Style.’ Selanjut-nya
anda dibawa ke halaman
‘Configuration-Style:’ seperti di
atas. Setelah anda tentukan, klik
tombol ‘Change Type.’

Buka file halaman depan
situs anda dengan browser
Sekarang buka file HTML yang
berisi halaman depan situs anda,
biasanya diberi nama index.html
atau default.html. Setelah itu klik
menu View > Source untuk
melihat kode HTML-nya.

Tempelkan kode counter 
Setelah kode HTML untuk situs
anda terbuka, tentukan di baris
mana kode counter itu akan dile-
takkan. Biasanya counter diletak-
kan di bagian bawah halaman
situs. Kemudian klik tombol ka-
nan mouse lalu klik Paste.

7
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Memasukkan program counter di situs anda

Masukkan Account Number dan
Password
Sekarang masukkan Account
Number dan Password yang telah
anda peroleh sebelumnya. Lalu
klik tombol ‘LOG IN.’

12

Save 
Setelah kode Counter dimasukkan
ke dalam kode HTML situs anda,
segera klik menu File > Save. 

9

Statistik
Anda juga bisa melihat statistik
situs anda. Untuk itu, klik menu
‘Stats,’ maka akan tampil Web
statistik situs anda berupa hits per
jam, hari, dan bulan dan juga je-
nis browser yang paling banyak
dipakai.

15

Masuk ke TheCounter
Pada kotak alamat browser anda,
ketikkan www.thecounter.com.
Setelah masuk, segera klik
‘Register here!’

Perjanjian penggunaan
Seperti biasa, anda akan disajikan
syarat-syarat untuk menggunakan
fasilitas counter yang disediakan
situs ini. Untuk dapat mengguna-
kan fasilitas ini, anda harus
mengklik tombol ‘I Agree.’

1 2 Pengisian data
Isi data yang diminta oleh formulir
on line ini. Yang paling penting
adalah alamat situs anda. Setelah
selesai , klik tombol ‘CONTINUE. ‘

3

******

Salin kode HTML counter
Halaman ini berisi kode HTML
untuk counter. Sorot (highlight)
kode tersebut lalu klik tombol
kanan mouse untuk mengaktifkan
menu seperti diatas. Klik ‘Copy.’
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sikan program animasi ini dengan
moto ‘Create Flash... without Flash.’

Program yang baru memulai debut-
nya sejak dua tahun lalu itu, kini
sudah dalam versi 2. Sebagaimana
lazimnya sebuah program animasi,
SWiSH pun dilengkapi berbagai
efek built-in sejumlah 150, seperti
Explode, Vortex, 3D Spin, Snake dan
masih banyak lagi. Lalu untuk alat
anda bekerja, SWiSH dilengkapi alat
bantu untuk membuat garis, bentuk
segi tiga, elips, kurva, alur gerak
(motion path), sprite, dan tombol
rollover.

Bagi anda yang telah mempunyai

atau pernah menggunakan Flash,
SWiSH memberi kemudahan de-
ngan kemampuan untuk mengeks-
por file dalam format SWF—format
animasi yang digunakan oleh Flash.
Dengan demikian, animasi yang
anda buat dengan SWiSH dapat di-
putar atau dimainkan pada kompu-
ter yang telah mempunyai Flash
Player.

Ikuti tutorial singkat di bawah ini
yang menyajikan proses langkah per
langkah pembuatan animasi dengan
SWiSH sebagaimana yang dapat
anda lihat sebagai pembukaan pada
situs NeoTek.

ika anda mengunjungi situs
NeoTek, anda akan disu-
guhi sebuah animasi seder-

hana. Animasi itu dibuat dengan
menggunakan program yang mirip
dengan Flash yaitu SWiSH
(hhttttpp::////sswwiisshhzzoonnee..  ccoomm). SWiSH
adalah program pembuat animasi
untuk teks, grafik, gambar, dan sua-
ra dengan teknik pembuatan yang
jauh lebih sederhana dibandingkan
Flash yang keluaran Macromedia
itu. Dengan iming-iming bahwa
anda dapat menciptakan animasi
hanya dalam waktu lima menit, DJJ
Holdings—perusahaan pembuat
SWiSH dari Australia—memposi-

SWSWiiSSHH
MMEENNCCIIPTPTAKAKAN ANAN ANIIMAMASSII
FFLLAASSH TH TANANPPAA
MMEENNGGGGUUNAKNAKAN FAN FLLAASSHH
Gunakan SWiSH untuk menghadirkan animasi di situs anda.
Program ini makin banyak diminati orang karena mudah
penggunaannya.

J

Download SWiSH
Masuk ke homepage Swish di
http://swishzone.com. Lalu
download program trial-nya dan
instal. Ikuti aturan instalasinya.

1
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Membuat animasi dengan SWiSH

3
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Memasukkan teks
Setelah anda menjalankan pro-
gram SWiSH, pada work bar di
sisi kiri terlihat ‘Untitled: Scene
1.’ Anda dapat mulai membuat
animasi dengan memasukkan
teks. Pada contoh ini kami
membuat teks ‘NeoTek.’

Efek pada teks pertama
Sekarang klik timeline bar. Frame
NeoTek dipasang pada 0 (nol).
Tambahkan efek ‘Hide.’ Pada
frame berikutnya, pilih efek
‘Explode.’

Menambahkan scene
Setelah selesai dengan teks, mari
mencoba animasi gambar. Tam-
bahkan scene dengan ‘Scene 2.’
Pada working bar, klik ‘Insert
scene.’

Teks kedua
Sekarang masukkan kembali teks.
Ketik ‘Dunia Teknologi Baru’. Lalu
geser teks tersebut dengan meng-
gunakan mouse pada layar ‘Pre-
view’ sehingga teks bergeser ke
bawah tulisan NeoTek.

Memberikan efek
Klik kembali ‘Timeline Bar’ kemu-
dian tambahkan efek ‘Hide’ pada
frame 0 dan  efek ‘Typewriter’
pada frame 20. Lalu pada frame
90 tambahkan efek ‘Slide out’
untuk keduanya.

Menambahkan efek
Anda dapat menambahkan efek
yang lain bergantung selera anda.
Sebagai contoh, kami menam-
bahkan efek ‘Wave’ pada teks
‘NeoTek’ pada frame 50. Jalankan
animasi pertama anda.

Gambar selanjutnya
Masukkan gambar kedua ke
Scene 2. Lalu tambahkan efek
‘Hide.’ Gunakan fitur ‘Transform’
dengan seting ‘Scale Factor of
10%.’

Memberi efek animasi
Kemudian klik ‘Transform bar’ di
sebelah ‘Start at.’ Pada ‘Scale’
tentukan ‘Resize back to 100%’
dan pada ‘Rotate’ atur ‘Rotate CW
by 360°.’ Lalu tambahkan ‘Show’
pada frame terakhir.

Memutar animasi
Kini anda siap memainkan atau
memutar semua animasi yang
sudah anda buat. Klik tombol ‘Play’
untuk melihat hasil akhir animasi
anda.

Memasukkan gambar
Klik tombol ‘Insert image,’ lalu
masukkan image atau gambar
yang anda inginkan, lalu klik OK.
Akan terlihat file image sudah
berada di bawah Scene 2.

Efek untuk gambar
Masukkan efek ‘Show’ pada frame
0, lalu pada frame 1 masukkan
efek ‘Transform’ dengan ‘Scale de-
crease by 80%’ dan ‘Rotate CW by
360°.’ Setelah itu pada frame se-
lanjutnya masukkan efek ‘Show.’

Scene Bagian dari
rangkaian animasi yang
dapat berupa teks atau
gambar yang terdiri dari beberapa frame.

Timeline Pengaturan durasi sebuah scene
—jumlah frame pada suatu scene. Timeline da-
pat digunakan untuk mengatur dan mengga-
bungkan animasi berbagai teks atau gambar.

Frame Bagian-bagian dari film atau movie
yang dibuat dengan SWiSH. Konsep frame
pada SWiSH mirip dengan frame pada
gambar hidup.

Movie Kumpulan beberapa scene. Movie
berisi scene, object, effect, dan action karena
semua unsur inilah sebenarnya yang
membentuk animasi pada movie.

Object Pada SWiSH, object dapat berupa
simple object dan complex object. Yang
dimaksud simple object adalah gambar atau
image, sedangkan teks dianggap sebagai
complex object.

DDAFAFTTARAR
IISSTTIILLAHAH
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ERNAH SUATU KETIKA pada
tanggal 10 Agustus 2001
sebuah media massa online
memberitakan mengenai

hacker yang membobol dan men-
deface (mengubah isi maupun tata
letak) beberapa situs di Internet dan
memasang foto Tommy Soeharto di
situs tersebut. Menurut media massa
tersebut, aksi hacker itu merupakan
bantuan untuk menyebarluaskan dan
menangkap Tommy Soeharto. Pada
halaman yang di-deface tersebut,
tertulis juga pesan ‘Hacked and de-
face not only a crime. This person is
#1 criminal in our country.’

Kemudian belum lama berselang,
tepatnya pada tanggal 16 Agustus
2001, beberapa perusahaan dotcom
menyelenggarakan sebuah acara ber-
tajuk HackersNight, di sebuah kafé di
bilangan Jakarta Selatan. Acara
Hackers Night tersebut merupakan
acara bulanan yang sudah mencapai
putaran ke 12 di Jakarta. Acara party-
party ala pebisnis dotcom tersebut
juga dilangsungkan di Bandung dan
Surabaya, dan sudah tentu dilaksana-
kan di sebuah café pula. Acara yang
dilangsungkan hingga larut malam
tersebut banyak menyajikan aneka
hiburan, musik yang keras dan
setumpuk hadiah dari para sponsor.

Bagi orang awam, kedua informasi
tersebut tidak menunjukkan kejang-
galan apa pun. Toh memang akhirnya
terminologi hacker bagi orang awam
tidak mempunyai banyak arti dan
tidak berpengaruh banyak dalam
kehidupan sehari-hari mereka. Tetapi
bagi pelaku dan pemain industri
teknologi informasi (TI), atau seti-
daknya bagi pemerhati dan pecinta
TI, penggunaan kata hacker untuk
dua contoh kasus tersebut di atas bisa
menjadi suatu diskusi yang panjang.
Ada pertanyaan yang paling menda-
sar: “Sudah tepatkah penggunaan
kata hacker tersebut?” Untuk men-
jawab pertanyaan tersebut, ada baik-
nya kita memahami terminologi
hacker lebih jauh.

Riwayat terminologi hacker
Terminologi hacker muncul  pada
awal tahun 1960-an diantara para
anggota organisasi mahasiswa Tech
Model Railroad Club di Laboratori-
um Kecerdasan Artifisial Massachu-
setts Institute of Technology (MIT).
Kelompok mahasiswa tersebut me-
rupakan salah satu perintis perkem-
bangan teknologi komputer dan me-
reka berkutat dengan sejumlah kom-
puter mainframe. Kata hacker perta-
ma kali muncul dengan arti positif

Dewasa ini para hacker selalu menjadi sasaran tudingan jika
terjadi tindak kriminal lewat komputer, padahal pada awalnya
istilah hacker digunakan untuk orang yang jempolan dalam
pemrograman komputer. Mengapa perubahan makna itu terjadi?
Donny B.U. mengupas latar belakangnya untuk anda.

P

HackHackerer
Riwayatmu Kini...Riwayatmu Kini...

We ex
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untuk menyebut seorang anggota
yang memiliki keahlian dalam bidang
komputer dan mampu membuat pro-
gram komputer yang lebih baik ke-
timbang yang telah dirancang bersama.

Kemudian pada tahun 1983, analogi
hacker semakin berkembang untuk
menyebut seseorang yang memiliki
obsesi untuk memahami dan me-
nguasai sistem komputer. Pasalnya,
pada tahun tersebut untuk pertama
kalinya FBI menangkap kelompok
kriminal komputer The 414s yang
berbasis di Milwaukee AS. 414
merupakan kode area lokal mereka.
Kelompok yang kemudian disebut
hacker tersebut dinyatakan bersalah
atas pembobolan 60 buah komputer,
dari komputer milik Pusat Kanker
Memorial Sloan-Kettering hingga
komputer milik Laboratorium Nasio-
nal Los Alamos. Salah seorang dari
antara pelaku tersebut mendapatkan
kekebalan karena testimonialnya, se-
dangkan 5 pelaku lainnya mendapat-
kan hukuman masa percobaan. Pada
tahun yang sama keluar pula sebuah
film berjudul War Games yang salah
satu perannya dimainkan oleh Mat-
thew Broderick sebagai David Light-
man. Film tersebut menceritakan se-
orang remaja penggemar komputer
yang secara tidak sengaja terkoneksi
dengan super komputer rahasia yang
mengkontrol persenjataan nuklir AS.

Kemudian pada tahun 1995 keluarlah
film berjudul Hackers, yang menceri-
takan pertarungan antara anak muda
jago komputer bawah tanah dengan
sebuah perusahaan high-tech dalam
menerobos sebuah sistem komputer.
Dalam film tersebut digambarkan ba-
gaimana akhirnya anak-anak muda
tersebut mampu menembus dan me-
lumpuhkan keamanan sistem kom-
puter perusahaan tersebut. Salah satu
pemainnya adalah Angelina Jolie yang
berperan sebagai Kate Libby alias
Acid Burn. Pada tahun yang sama
keluar pula film berjudul The Net
yang dimainkan oleh Sandra Bullock
sebagai Angela Bennet. Film tersebut
mengisahkan bagaimana perjuangan
seorang pakar komputer wanita yang
identitas dan informasi jati dirinya di
dunia nyata telah diubah oleh seseo-
rang. Dengan keluarnya dua film ter-
sebut, maka makna terminologi hack-
er semakin jauh dari yang pertama kali
muncul di tahun 1960-an di MIT.

Hacker dan cracker
Sebenarnya secara lebih spesifik
terminologi hhaacckkeerr telah dijelaskan
dalam buku Hacker Attack karya
Richard Mansfield tahun 2000.

Menurut Mansfield, hacker didefini-
sikan sebagai seseorang yang memi-
liki keinginan untuk melakukan eks-
plorasi dan penetrasi terhadap sebuah
sistem operasi dan kode komputer
pengaman lainnya, tetapi tidak mela-
kukan tindakan perusakan apa pun,
tidak mencuri uang atau informasi.
Sedangkan ccrraacckkeerr adalah sisi gelap
dari hacker dan memiliki kertertarik-
an untuk mencuri informasi, melaku-
kan berbagai macam kerusakan dan
sesekali waktu juga melumpuhkan
keseluruhan sistem komputer.

Perbedaan terminologi antar hacker
dan cracker tersebut kini menjadi bi-
as dan cenderung hilang sama sekali
dalam perspektif media massa dan di
masyarakat umum. Ada beberapa
faktor penyebab hal tersebut:

•Para cracker tidak jarang menyebut
diri mereka sebagai hacker 

•Manifesto dan kode etik para hacker
kerap pula dianggap sebagai manifes-
to dan kode etik bagi para cracker.

•Media massa menggunakan termi-
nologi hacker secara salah kaprah dan
hantam kromo

• Industri film mengangkat kehidup-
an hacker dari kacamata Hollywood

Manifesto Hacker

Hacker memiliki manifesto dan kode etik yang menjadi patokan bagi hacker di seluruh
dunia. Manifesto Hacker dibuat oleh seorang hacker yang menggunakan nickname The
Mentor dan pertama kali dimuat pada majalah Phrack (volume 1 / issue 7 / 25
September 1986). Manifesto Hacker tersebut adalah:

Ini adalah dunia kami sekarang, dunianya elektron dan switch, keindahan sebuah
baud. Kami mendayagunakan sebuah sistem yang telah ada tanpa membayar, yang
bisa jadi biaya tersebut sangatlah murah jika tidak dijalankan dengan nafsu tamak
mencari keuntungan, dan kalian sebut kami kriminal.

Kami menjelajah, dan kalian sebut kami kriminal.

Kami mengejar pengetahuan, dan kalian sebut kami kriminal.

Kami hadir tanpa perbedaan warna kulit, kebangsaan, ataupun prasangka
keagamaan, dan kalian sebut kami kriminal.

Kalian membuat bom atom, kalian menggelar peperangan, kalian membunuh,
berlaku curang, membohongi kami dan mencoba meyakinkan kami bahwa semua itu
demi kebaikan kami, tetap saja kami yang disebut kriminal.

Ya, aku memang seorang kriminal. 

Kejahatanku adalah rasa keingintahuanku.

Kejahatanku adalah karena menilai orang lain dari apa yang mereka katakan dan
pikirkan, bukan pada penampilan mereka.

Kejahatanku adalah menjadi lebih pintar dari kalian, sesuatu yang tak kan kalian
maafkan.

Aku memang seorang hacker, dan inilah manifesto saya.

Kalian bisa saja menghentikanku, tetapi kalian tak mungkin menghentikan kami
semua.

Bagaimanapun juga,  kami semua senasib seperjuangan.

•Bukan karena para hacker mau berpesta maka
diadakan Hackers Night (www.hackersnight.com).
Acara gaul ini cuma upaya beberapa pebisnis
supaya tidak terlalu berkencang urat dalam
mengurus bisnis Internet.

• Swordfish (www.operationswordfish.com)—
yang antara lain dibintangi oleh John Travolta—
mengisahkan seorang hacker yang terlibat dalam
upaya menjebol sistem komputer untuk menggaet
milyaran dolar dana pemerintah. 
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•Masyarakat melabelisasi kegiatan-
nya menggunakan kata hacker agar
lebih memiliki daya jual

Berdasarkan beberapa kondisi terse-
but di atas, maka terminologi hacker
memiliki pelebaran makna sedemiki-
an rupa, sehingga kesalah-kaprahan
kian hari kian menjadi-jadi. Setiap
perilaku negatif yang dilakukan di
Internet sering kali dikaitkan dengan
istilah hacker, baik oleh media massa
maupun masyarakat umum.
Contohnya adalah pada paragraf
pertama dan kedua tulisan ini.
Perilaku men-deface suatu situs
nyata-nyata bukanlah modus
operandi hacker. Hacker sejatinya
tidak memiliki niatan atau tindakan
yang sifatnya merusak. Penggunaan
kata hacker untuk sebuah acara
party-party di café seperti contoh di
atas juga merupakan satu bentuk
pengaburan makna hacker yang
sebenarnya. Acara Hackers Night
yang selalu digelar di café-café
tersebut hanyalah merupakan ajang
kumpul-kumpul pebisnis dotcom
untuk bertukar kartu nama, menik-
mati hiburan dan bercengkerama
hingga larut malam. Agak sulit jika
ingin memperkirakan bahwa hacker
yang sebenarnya akan menghadiri
acara tersebut. Karena sejatinya se-
orang hacker kurang mau jati
dirinya terekspos. Berbeda bila kita
berbicara mengenai ajang pertemuan
hacker terbesar di dunia, Def Con,
yang diadakan setahun sekali setiap
pertengahan bulan Juli di Las Vegas.
Acara Def Con tersebut lebih kepada
ajang pertukaran informasi dan
teknologi yang berkaitan dengan

aktivitas hacking. Para hacker dari
seluruh dunia tidak segan-segan
untuk muncul setahun sekali dalam
Def Con tersebut karena di situlah
mereka dapat merasakan berada di
komunitas hacker yang
sesungguhnya, bukan sekedar
labelisasi saja.

Walhasil, melihat beberapa kondisi
di atas, akhirnya mau tidak mau
terjadi kompromi dalam penggunaan
istilah hacker. Sebagian orang ada
memilih istilah hacker dan cracker,
ada yang lebih nyaman
menggunakan istilah hacker putih
dan hacker hitam dan ada pula yang
tetap menggunakan kata hacker
untuk semua perilaku kriminalitas
di Internet. Karena hacker yang
sejati lebih banyak diam, cracker
sering menyatakan dirinya sebagai
hacker dan masyarakat umum lebih
familiar dengan istilah hacker,
akhirnya mau tidak mau media mas-
sa harus mengikuti selera pasar de-
ngan ikut-ikutan mengeneralisir
terminologi hacker.

*) Donny B.U. adalah anggota
PRASASTI (www.prasasti.web.id),
Pemerhati Computer-Mediated
Communication, dan Kandidat Magister
Sains Manajemen Komunikasi UI
e-mail: donnybu@prasasti.web.id
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Kode Etik Hacker

Hacker juga memiliki kode etik yang pada mulanya diformulasikan dalam buku karya
Steven Levy berjudul Hackers: Heroes of The Computer Revolution, pada tahun 1984.
Kode etik hacker tersebut tertulis:

1. Akses ke sebuah sistem komputer, dan apapun saja dapat mengajarkan
mengenai bagaimana dunia bekerja, haruslah tidak terbatas sama sekali

2. Segala informasi haruslah gratis

3. Jangan percaya pada otoritas, promosikanlah desentralisasi

4. Hacker haruslah dinilai dari sudut pandang aktifitas hackingnya, bukan
berdasarkan standar organisasi formal atau kriteria yang tidak relevan seperti
derajat, usia, suku maupun posisi.

5. Seseorang dapat menciptakan karya seni dan keindahan di komputer

6. Komputer dapat mengubah kehidupan seseorang menjadi lebih baik.

•Def Con (www.defcon. org) adalah ajang
kumpul-kumpul para hakcer yang mengklaim

dirinya sebagai ‘the largest underground internet
security gathering on the planet.’ Di situs organisasi
anda bisa menemukan banyak link yang berguna

anda yang ingin mempelajari per-hacking-an.

Download AATools
Buka browser anda dan ketikkan
URL: www.glocksoft.com.
Setelah masuk, segera cari
AATools v.4.31 dan klik
download.

1

Untuk bersih-bersih file
Jika anda ingin membersihkan
file regsitry yang tidak terpakai
lagi dan hanya membuat kom-
puter anda menjadi lemot, klik
Tool > Registry Cleaner. Lalu
klik Scan dan setelah selesai klik
Clean.

5

dvanced Administrative Tools
(AATools) adalah piranti diag-
nostik jaringan (network). Pi-

ranti (tool) ini dapat dikatakan alat diag-
nostik serba guna (11 in 1) karena di da-
lamnya anda dapat menjumpai 11 utili-
tas: Port Scanner, Proxy Analyzer, CGI
Analyzer, Email Verifier, Links Analyz-
er, Network Status, Process Info, Whois,
System Info, Resource Viewer dan Regis-
try Cleaner. Tujuannya adalah untuk
mengumpulkan data yang berhubung-
an dengan status keamanan jaringan
dengan menggunakan tool paling mu-
takhir dalam studi riset jaringan.

Port Scanner, misalnya, dapat mendeteksi
secara akurat port-port mana yang aktif
pada suatu host dengan menggunakan
interogasi baik port TCP maupun UDP.
Informasi ini sangat kritis untuk mem-
bangun sistem keamanan di dunia maya.

A

Ketahuan deh...
Sekarang anda bisa tahu di ma-
na lokasi server situs NeoTek
dijalankan. Sederhana bukan?
Jadi sekarang jelas, dengan
menggunakan tool Whois, anda
bisa tahu siapa yang menjalan-
kan situs tersebut.

4Whois NeoTek? 
Sekarang kita coba salah satu tool
yaitu Whois. Klik Tools > Whois.
Sebagai contoh kami membuka
situs kami NeoTek dengan menge-
tikkan URL www.neotek.co.id pa-
da kotak Host Name or IP. Lalu
klik tombol Start. 

3

Verifikasi email
Apakah alamat email teman anda
benar atau tidak, cek saja dengan
mengklik Tools > E-mail Verifier.
Lalu ketik alamat email pada
kotak yang disediakan dan klik
Add. Selanjutnya klik Start dan
AATools segera mengeceknya.

6

The only secure computer is one that's unplugged, locked in a safe, and buried 20 feet under the ground
in a secret location...and i'm not even too sure about that one —Dennis Huges, FBI. 

Deskripsi Tool 
Segera instal dan jalankan pro-
gram tersebut. Bila anda kurang
paham dengan istilah tool yang
ada, jangan khawatir. Semua
telah diterangkan pada bagian
deskripsi seperti gambar di atas.
Sekali anda paham, bayangkan
keuntungan yang anda peroleh.

2

Identifikasi Si Kuda Troya
Apakah server situs anda sudah
bebas dari Trojan Horse? Untuk
memastikannya gunakan Port
Scanner. Klik Tools > Port Scanner
lalu ketik alamat situs. Klik Lookup
lalu klik Add dan klik TCP Scan.
Sekarang klik Scan. Hasilnya?

7
UDP Scan
Jika anda ingin mengetahui
protokol UDP, pilih ‘Everything’
pada ‘Port Set’ lalu klik ‘ Smart
Sca’n dan klik ‘Scan.’ Hasilnya
segera terlihat seperti gambar di
atas. Bingung? Coba klik menu
Help. 

8

BBEELLAAJJAR JAR JADADI HAI HACCKKEER?R?
COCOBBA DA DUULU LU 
AAAATTOOOOLLSS
AATools diciptakan untuk mencari lubang-lubang kelemahan
sistem kompu-ter anda sebelum mereka menemukannya. Sis-
tem keamanan suatu komputer sangat tergantung pada keah-
lian Security Administrator. Program ini diciptakan untuk menguji
seberapa ketat keamanan komputer anda.   

• Selain Advanced Administrative Tools (AATools), G-Lock
Software (wwwwww..gglloocckkssoofftt..ccoomm) pun menyediakan produk
menarik lain, seperti Activity and Authentication Analyzer,

Advanced Email Verifier, dan G-Lock EasyMail. Sementara itu,
pada menu ‘Supports,’ G-Lock memberikan daftar port Trojan
untuk membantu anda mengidentifikasi kemungkinan Trojan

yang menginfeksi komputer anda.
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sebagai “seseorang yang
masuk ke sistem orang
lain, biasanya di jaringan
komputer, mem-bypass
password atau lisensi pro-
gram komputer, atau secara
sengaja melawan keaman-
an komputer. Cracker dapat
mengerjakan hal ini untuk
keuntungan, maksud jahat,
atau karena sebab lainnya
karena ada tantangan. Be-
berapa proses pembobolan
dilakukan untuk menun-
jukkan kelemahan keaman-
an sistem.”

Hacker menurut Eric Ray-
mond didefinisikan sebagai
pemrogram yang pandai.
Sebuah hack yang baik
adalah solusi yang cantik
atas masalah programming
dan “hacking” adalah pro-
ses pembuatannya. Menu-
rut Raymond ada 5 ciri
yang menandakan seseo-
rang adalah hacker, yaitu:

• Suka mempelajari  baha-
sa pemrograman atau
sistem secara rinci.

• Dapat melakukan pemro-
graman, tidak hanya teori.

• Bisa meng
xhargai, menik-
mati hasil hack-
ing orang lain.

• Dapat cepat
belajar pemro-
gramman.

• Ahli bahasa
pemrograman
tertentu atau
sistem tertentu,
seperti “UNIX
hacker.”

Sombong
Sombong meru-
pakan salah satu
sebab utama se-
orang hacker
tertangkap. Mere-
ka menyombongkan diri
dan memproklamirkan apa
yang mereka capai untuk
memperoleh pengakuan
dari yang lain. Hacker lain,
karena pengetahuannya
masih kurang, biasanya
memilih target secara hati-
hati. Secara perlahan hie-
rarki mereka akan naik se-
suai kemampuannya, tanpa
menyombongkan diri.

Hacker menolong
industri 
Umumnya pembuat soft-
ware akan sangat berteri-
ma kasih akan masukan
dari para hacker, karena
dengan adanya masukan
ini software yang mereka
buat menjadi semakin baik.
Memang kadang eksploit
yang dihasilkan para hack-
er tidak langsung diperoleh
si perusahaan software,

tetapi ditahan oleh komu-
nitas underground ini—
sampai digunakan oleh
lamers dan membuat
kekacauan.

Aturan main hacker 
Gambaran umum aturan
main yang seorang hacker
dijelaskan oleh Scorpio
http://packetstorm.securify
.com/docs/hack/ethics/my.c
ode.of.ethics.html, yaitu:

Aktivitas para hacker sering menjadi buah bibir
orang dan umumnya pendapat orang mengenai
mereka lebih ke nada minor. Tetapi benarkah
demikian? Onno W. Purbo mengulasnya.

ANYAK ARTIKEL DAN
tulisan di media
tentang 'hacker',
tapi tidak banyak

yang membahas tentang
budaya, etika, aturan yang
mengatur komunitas mis-
terius ini. Sebuah masya-
rakat yang hanya ada dan
dikenal di dunia under-
ground (demikian istilah
mereka). Tulisan ini disa-
dur dari beberapa bahan di
Internet underground se-
perti tulisan Gilbert Ala-
verdian dan akan mencoba
membahas hal-hal ini, agar
masyarakat umum dapat
mengerti sedikit tentang
sub-kultur dunia ‘bawah
tanah’ itu.

Anggapan umum
Di media dan masyarakat
ada anggapan bahwa hacker
adalah orang yang jahat
dan suka merusak. Padahal
hacker tidak seperti yang
dibayangkan banyak
orang. Stereotipe ABG 15
tahun, yang duduk di bela-
kang komputer berjam-
jam, masuk ke sistem dan
men-delete atau menghan-
curkan apa saja yang bisa

mereka hancurkan —
“anak” ini dikenal sebagai
ccrraacckkeerr bukan hhaacckkeerr.
Cracker ini yang sering
anda dengar di berita atau
media, mematikan situs
Web, menghapus data dan
membuat kekacauan kema-
napun mereka pergi.

Di dunia elektronik bawah
tanah, nama jarang digu-
nakan. Orang biasanya
menggunakan nama alias,
callsign atau nama samar-
an. Hal ini memungkinkan
orang menyamarkan iden-
titas dirinya, tetapi tetap di
kenali sesama anggota ko-
munitas underground.

Hacker vs cracker
Apakah perbedaan men-
dasar antara cracker dan
hacker? Di wwwwww..wwhhaattiiss..
ccoomm, cracker didefinisikan

Kecoa Elektronik
www.k-elektronik.org

Halaman muka situs milik
rekan-rekan dari Kecoa
Elektronik yang cukup
menyeramkan dengan
warna dasar hitam dan
potingan muka kecoa ke
emas-an menonjol ke luar
dari warna dasarnya.

Ada beberapa menu yang
dapat dipilih untuk melihat
informasi lebih lanjut.

B

MasyarMasyarakatakat HackHackerer

BEBERAPA NAMA
populer di antara
hacker Indonesia

bisa dikenali seperti
hC, cbug, litherr, fwerd,

d_ajax, r3dshadow, cwarrior,
ladybug, chiko, gelo,
BigDaddy dsb.

INFO

NEOTEK

Bagian yang cukup mena-
rik untuk dikunjungi oleh
pemula adalah tutorial un-
tuk menjadi hacker kelas
rendahan, istilah keren-
nya script kiddies.

Di situ dijelaskan langkah
yang perlu dilakukan oleh
hacker pemula, di lengkapi
dengan beberapa script
untuk di coba.

Perlu diperhatikan di sini
bahwa hacker yang baik
tidak akan merusak mesin
yang diserang, ada baiknya
membaca-baca tentang
etika hacking untuk men-
jadikan anda hacker yang
baik.

Yang tidak kalah menarik
adalah bagian majalah
(ezine) Kecoa Elektronik,
yang saat tulisan ini dibuat
telah mencapai edisi 4. e-
zine tersebut memuat arti-
kel yang menjelaskan rin-
cian teknik hacking.

Umumnya teks artikel da-
lam format teks ASCII bu-
kan HTML, sehingga seper-
ti tidak menarik untuk
pengguna Web biasa, tetapi
memang demikianlah dunia
underground—mereka bia-
sanya menggunakan for-
mat ASCII untuk menulis-
kan berbagai dokumen.

Salah satu contoh artikel di
e-zine Kecoa Elektronik
yang berjudul “Tutorial
Back Orifice” yang ditulis
oleh skwp. Terlihat jelas
teksnya ditulis mengguna-
kan format teks ASCII.

Hackerlink
www.hackerlink.or.id

Situs hacker Indonesia
yang lain adalah
Hackerlink.

Tampilannya lebih cantik
daripada Kecoa Elektronik,
sayangnya bagi saya yang
mengaskes dari IndoNet
terasa lebih lambat.

Tidak banyak yang dapat
dilihat di situs ini, teru-
tama yang bermanfaat
adalah berita hacker.

Fasilitas Free webmail di
sediakan oleh situs
Hackerlink.

Tentunya anda harus me-
lakukan registrasi dahulu
sebelum menggunakan
webmail mereka.

Situs hacker Indonesia Situs hacker Indonesia

• Intel jadi bahan
guyonan. Gambar di
samping seakan mewa-
kili suara para hacker
tentang kemampuan
mereka ‘mengintip’ isi
komputer para peng-
guna komputer di
seluruh dunia.

•Aturan main
hacker? Hacker pun
mempunyai aturan main
yang tidak tertulis. Tetapi
apakah seorang hacker
yang tidak mengikuti
aturan main tersebut
akan di-’setrap’ dan
dihukum menulis 1000
baris kalimat “I will not
shut down major e-
commerce sites’?
(http://cagle.slate.msn.c
om/news/hackers/hacke
r13.asp)

http://cagle.slate.msn.com/news/hackers/ hacker13.asp



• Di atas segalanya, hormati
pengetahuan dan kebe-
basan informasi.

• Beritahukan sistem ad-
ministrator akan adanya
pelanggaran keamanan
atau lubang di keamanan
yang anda lihat.

• Jangan mengambil keun-
tungan tidak fair dari hack.

• Jangan mendistribusikan
dan mengumpulkan
software bajakan.

• Jangan pernah mengambil
risiko yang bodoh—keta-
hui kemampuan  sendiri.

• Selalu bersedia secara
terbuka, bebas, gratis
memberitahukan dan
mengajarkan berbagai

informasi dan metode
yang diperoleh.

• Jangan pernah meng-
hack sebuah sistem un-
tuk mencuri uang.

• Jangan memberikan ak-
ses ke seseorang yang
akan membuat kerusakan.

• Jangan pernah secara se-
ngaja menghapus dan

merusak file di komputer
yang di-hack.

• Hormati mesin yang di
hack, dan perlakukan
seperti mesin sendiri.

Jelas dari aturan main di
atas, tidak mungkin se-
orang hacker ‘betulan’ akan
membuat kerusakan di
komputer. NT
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ANG MENARIK, ter-
nyata dalam du-
nia hacker terjadi

strata-strata (tingkatan)
yang diberikan oleh komu-
nitas hacker kepada seseo-
rang karena kepiawaian-
nya, bukan karena umur
atau senioritasnya. Saya
yakin tidak semua orang
setuju dengan derajat yang
disajikan di sini, karena
ada kesan arogan terutama
pada level yang tinggi. Un-
tuk memperoleh pengaku-
an, seorang hacker harus
dapat membuat program
untuk mengeksploit
kelemahan sistem, menulis
tutorial (artikel), aktif
berdiskusi di mailing list,
membuat situs Web dsb.

Hierarki Hacker
Mungkin agak terlalu ka-
sar jika disebut hierarki
atau tingkatan hacker; saya
yakin istilah ini tidak sepe-
nuhnya bisa diterima oleh
masyarakat hacker. Oleh

karenanya saya meminta
maaf sebelumnya. Secara
umum yang paling tinggi
(suhu) hacker sering dise-
but ‘Elite’; di Indonesia
mungkin lebih sering di
sebut ‘suhu’. Sedangkan, di
ujung lain derajat hacker
dikenal ‘wanna-be’ hacker
atau dikenal sebagai 'Lamers.’

Elite
Juga dikenal sebagai 3l33t,
3l337, 31337 atau kombi-
nasi dari itu; merupakan
ujung tombak industri ke-
amanan jaringan. Mereka
mengerti sistem operasi
luar dalam, sanggup meng-
konfigurasi dan menyam-
bungkan jaringan secara
global. Sanggup melaku-
kan pemrograman setiap
harinya. Sebuah anugrah
yang sangat alami, mereka
biasanya efisien dan te-
rampil, menggunakan pe-
ngetahuannya dengan
tepat. Mereka seperti silu-
man dapat memasuki sis-
tem tanpa diketahui, wa-

laupun mereka tidak akan
menghancurkan data-data,
karena mereka selalu me-
ngikuti peraturan yang
ada. Salah satu suhu
hacker di Indonesia yang
saya hormati dan kagumi
kebetulan bekas murid
saya sendiri di Teknik
Elektro ITB, beliau relatif
masih muda. Sekarang te-
lah menjadi orang penting
di Research & Develop-
ment Telkomsel.

Semi elite 
Hacker ini biasanya lebih
muda daripada Elite. Mere-
ka juga mempunyai ke-
mampuan dan pengetahu-
an luas tentang komputer.
Mereka mengerti tentang
sistem operasi (termasuk
lubangnya). Biasanya di-
lengkapi dengan sejumlah
kecil program cukup untuk
mengubah program eks-
ploit. Banyak serangan
yang dipublikasi dilakukan
oleh hacker kaliber ini,
sialnya oleh para Elite
mereka sering kali di
kategorikan Lamer.

Developed Kiddie
Sebutan ini terutama kare-
na umur kelompok ini ma-
sih muda (ABG) dan ma-
sih sekolah. Mereka mem-
baca tentang metode hack-
ing dan caranya di berba-
gai kesempatan. Mereka
mencoba berbagai sistem
sampai akhirnya berhasil
dan memproklamirkan
kemenangan ke yang lain.
Umumnya mereka masih

menggunakan Grafik User
Interface (GUI) dan baru
belajar basic dari UNIX,
tanpa mampu menemukan
lubang kelemahan baru di
sistem operasi.

Script Kiddie
Seperti Developed Kiddie,
Script Kiddie biasanya me-
lakukan aktivitas di atas.
Seperti juga Lamers, mere-
ka hanya mempunyai pe-
ngetahuan teknis network-
ing yang sangat minimal.
Biasanya tidak lepas dari
GUI. Hacking dilakukan
menggunakan trojan un-
tuk menakuti dan menyu-
sahkan hidup sebagian
pengguna Internet.

Lamer
Mereka adalah orang tanpa
pengalaman dan pengeta-
huan yang ingin menjadi
hacker (wanna-be hacker).
Mereka biasanya membaca
atau mendengar tentang
hacker dan ingin seperti
itu. Penggunaan komputer
mereka terutama untuk
main game, IRC, tukar
menukar software pribadi,
mencuri kartu kredit. Bia-
sanya melakukan hacking
dengan menggunakan
software trojan, nuke dan
DoS. Biasanya menyom-
bongkan diri melalui IRC
channel dsb. Karena ba-
nyak kekurangannya un-
tuk mencapai elite, dalam
perkembangannya mereka
hanya akan sampai level
Developed Kiddie atau
Script Kiddie saja.

‘‘JJeennjjaanngg  KKaarriieerr’’  HHaacckkeerr
Dunia bawah tanah para hacker memberi jenjang atau hierarki bagi para anggotanya.
‘Kepangkatan’ diberikan berdasarkan kepiawaian seseorang dalam hacking.

Y
Situsnya PSitusnya Parara Hackera Hacker
New OrNew Orderder

NTUK MEMBERIKAN GAMBARAN sebuah situs
hacking yang menarik, saya mencoba membahas
tentang situs NNeewwOOrrddeerr  ((hhttttpp::////nneewwoorrddeerr..bbooxx..sskk))

yang memuat banyak sekali informasi yang akan sangat
berguna bagi para hacker baik level script kiddies maupun
yang lebih tinggi. Mohon berhati-hati dalam mengguna-
kan berbagai script dan program eksploit yang ada.
Kesulitan utama yang akan banyak dihadapi oleh rekan-
rekan hacker Indonesia hanyalah masalah bahasa Inggris
saja. Yah, hitung-hitung belajar bahasa Inggris sambil
belajar hacking.

U

Pada gambar tampak
halaman muka situs New
Order yang tampak cukup
seram dengan latar
belakang warna hitam.
Nampaknya warna hitam
menjadi favorit banyak
situs hacker yang berkesan
seram dan misterius.

Menu paling atas adalah
‘links’ yang merupakan
link ke berbagai topik
utama yang menarik
banyak hacker yang
mencari topik yang sangat
spesifik, seperti, eksploit
Windows95/98/NT, e-zine
underground, eksploit
UNIX dsb.

Setelah ‘links.’, ada kum-
pulan ‘articles’ dari berbagai
media, termasuk e-zine
underground yang menarik
bagi komunitas hacker.

Biasanya artikel terbaru
akan terpampang di hala-
man muka situs NewOrder.

Jika tertarik atau ingin me-
ngetahui tentang keamanan
di MS Windows 9x/NT/
2000/XF, anda dapat menilik
topik tersebut dari bagian
‘links’ di halaman muka.

Ada beberapa topik yang di-
arsip di bagian MS Win-
dows, seperti, Back Oriface,
Buku dan makalah tentang
Windows, Eksploit untuk
Windows, Password Cracker
di Windows, Tools Security
di Windows. Di samping itu,
ada informasi mailing list
yang membahas khusus
tentang security di Windows
seperti NTBuqTraq.

Bagi System Administrator
yang tidak menginginkan
server-nya di hack, maka
link kepada Windows OS
related tools akan menjadi
sangat menarik.

Pada link ini, disediakan ber-
bagai tool untuk memonitor
keamanan sistem operasi
dari serangan dan penyu-
supan dari cracker yang
tidak bertanggung jawab.

Seperti biasanya, bagian
yang juga akan menarik
untuk dibaca yang terdapat
pada daftar ‘links’ di hala-
man muka adalah majalah
elektronik (e-zine).

e-zine underground ini akan
sangat menarik untuk dibaca
dan dinikmati, karena infor-
masinya biasanya tidak akan
diperoleh di majalah lain di
dunia nyata.

Beruntung majalah jenis ini
cukup banyak, sehingga da-
pat menjadi sumber penge-
tahuan yang baik dan ins-
pirasi bagi para hacker di
Indonesia.

Para hacker pasti akan terta-
rik untuk memasuki link
selanjutnya tentang eksploit
untuk Windows NT/98.

Cukup banyak script dan
eksploit yang dapat diguna-
kan untuk membuat server
NT/workstation Windows
98 menjadi mati. Script DoS
(Denial of Service) ini cukup
berbahaya jika digunakan
cracker yang tidak
bertanggung jawab.

Setelah kumpulan articles,
pada bagian paling bawah
adalah bagian yang paling
berbahaya: kumpulan ‘ex-
ploits’ terbaru dari dunia
underground.

Sebagian berupa tulisan,
sebagian berupa source code,
sebagian merupakan binary
yang sudah di-compile.

• Billy baru mencapai tingkatan script kiddie?

Situs New Order
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Remote Administration Tool
Sebagai remote administration tool,
BO memungkinkan pengendalian
komputer yang bersistem operasi
Windows atau Unix melalui koneksi
TCP/IP—baik pada LAN maupun
Internet—dengan konsol grafis
yang mudah digunakan.

Komputer yang hendak dikendalikan
harus menjalankan bboosseerrvvee..eexxee se-
dangkan pengendalinya menjalan-
kan bboogguuii..eexxee..

Seseorang dapat menyamarkan
boserve.exe dalam, misalnya, gam-
bar kartun dan mengirimkannya
lewat email attachment kepada

anda. Anda membuka file itu dan
tanpa diketahui pada komputer anda
telah terpasang boserve.exe.

Seseorang yang menjalankan bogui.exe
dapat men-scan IP address komputer-
komputer yang terhubung ke Inter-
net. Siapa tahu ada yang terinfeksi
oleh boserve. Sekali IP address-nya
diketahui, orang itu dapat mengen-
dalikan sepenuhnya komputer anda!

Bagaimana Mencegah Terinfeksi BO
Antivirus adalah perlengkapan mini-
mal yang perlu dipasang di setiap
komputer sekarang. Norton Antivirus
maupun McAfee mampu mendeteksi
BO maupun trojan lainnya.

alaupun diluncurkan sebagai
administration tool yang
memungkinkan pengendalian

komputer dari jauh, dalam kenyataannya
program ini berkembang menjadi trojan
horse (kuda troya), yaitu software yang
diam-diam masuk ke komputer lewat
jalan belakang pada Windows. Maka
namanya pun Back Orifice (saluran
belakang)—dikenal sebagai BO.

Walaupun BO bukanlah virus, tetapi dapat
sama berbahayanya dengan virus. Bayang-
kan bila diam-diam seseorang dari jauh
dapat mengutak-atik hard disk anda, terma-
suk memformatnya! Itu sebabnya program
antivirus juga mengawasi berbagai jenis
trojan.

HAHACCKKIINNG IG ITTU GU GAMAMPPANANGG
PPAKAKAI SAI SAAJJAA
BACBACK OK ORRIIFFIICCEE
Back Orifice keluaran Cult of the Dead Cow (cDc), kelompok
hacker paling berpengaruh itu, sebenarnya dimaksudkan sebagai
administration tool, namun sifat-sifatnya membuatnya mudah
digunakan sebagai alat hacking…

W

Pengamanan diri sendiri
Main-main begini ada bahayanya juga.
Bisa saja bogui.exe yang kita jalankan
itu mengandung boserve.exe tanpa kita
sadari (buatnya dengan fasilitas Plugin).
Untuk memastikannya klik Start, Run,
ketik Regedit dan klik OK untuk
membuka Registry Editor. Pilih (klik)
HKEY_LOCAL_MACHINE

(Default) harus kosong
Selanjutnya pilih Software > Microsoft
> Windows > CurrentVersion. Perhati-
kan entri pertama Name: (Default),
Data: (value not set) yang berarti aman!
Bila terpasang boserve.exe, maka pada
Data terlihat  .exe (spasi dot exe). Hapus
bila ada!

Alert dari norton antivitus 2001
Apabila komputer anda dilindungi oleh
antivirus, maka ke-4 komponen utama
itu akan dikenali sebagai trojan. Di sini
pilih ‘Ignore the problem and conti-
nue with the infected file.’ McAfee
juga mengenali BO ini. Bila tidak mema-
sang antivirus pesan ini tidak muncul.

Simpan di direktori khusus
Misalkan anda telah menyiapkan direk-
tori khusus untuk file-file BO ini di
C:\BackOrifice. Tampak keempat kom-
ponen utama BO, utilitas kompresi
(freeze.exe dan melt.exe), serta dua
manual (bo.txt dan plugin.txt).

3
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MMAASSIIH BH BEELULUMM
PPUUAAS?S?

TIP & TRIK •TIP & TRIK •TIP & TRI

Jangan Jalankan boserve.exe
Sama sekali jangan jalankan
boserve.exe di komputer anda

apabila anda tidak ingin menjadi
korban oleh seseorang yang menja-
lankan bogui.exe entah dari mana

!

Main-main dengan bogui.exe
Dengan menjalankan bogui.exe
siapa pun bisa menjadi hacker.

Cari IP address komputer-komputer
yang terhubung ke Internet yang—tan-
pa diketahui—sudah terinfeksi oleh
boserve.exe

!

‘Otak udang’ pun dapat menjadi hacker dengan Back Orifice

LEBIH CANGGIH:
BO2K1

BO pertama kali diluncur-
kan pada tahun 1998.
BO2K ditulis oleh DilDoc
berdasarkan versi BO per-
tama buatan SirDystic (ke-
duanya anggota cDc).
Dapatkan BO2000 ini di
www.bo2k.com

BACK ORIFICE
BASICS2

Informasi dasar tentang BO
dapat diperoleh di:
http://www.nwinternet.com/
~pchelp/bo/bobasics.htm

BACK ORIFICE
FUN PAGE3

Di sini anda diajari langkah
demi langkah mulai dari
menjalankan bogui.exe,
mencari ‘korban’ dengan
sweeping IP address dan
logon ke IRC. Lalu cara-cara
menjahili orang. Etikanya
jangan merusak data orang!
www.phonelosers.org/
back_orifice.html

MENGHAPUS
BERSIH BO4

Langkah-langkah mengenali
apakah anda terinfeksi BO
dan bagaimana menghi-
langkannya baik dengan
software AntiBO atau secara
manual (sebab jangan-
jangan software AntiBO itu
justru diam-diam berisi B0)
http://www.irchelp.org/
irchelp/security/bo.html

MMARARI KI KITITAA
CCOOBA!BA!

DOWNLOAD
BACK ORIFICE1

Download BO dari situs
Cult of the Dead Cow:
www.cultdeadcow.com/
tools/bo.html
Anda dapat men-downlad
versi Windows ataupun
Unix dari beberapa mirror
site yang ada.

KOMPONEN
BACK ORIFICE2

File bo.zip terdiri dari
beberapa bagian:
bo.txt dokumentasi
plugin.txt plugin doc.
boserve BO self instal
bogui BO GUI client
boclient BO text client
boconfig utilitas
melt.exe decompressor
freeze.exe compressor

BOSERVE.EXE
YANG DIKONTROL3

Jalankan boserve.exe pada
komputer yang hendak di-
kendalikan dari jauh.
Begitu dieksekusi, program
ini menginstal lalu meng-
hapus dirinya sendiri.
Begitu terinstal program
server ini akan secara
otomatis berjalan setiap
kali mesin itu di-boot.

BOGUI.EXE
PENGENDALINYA4

Jalankan bogui.exe, client
software untuk mengen-
dalikan komputer dari
jauh yang telah terpasang
boserve.exe 

Tampilan bogui.exe
Klik dua kali ikon bogui.exe dan
software pengendali BO ini akan dija-
lankan (bila terpasang, Norton Antivirus
akan menyampaikan peringatan lagi).
‘Korban’ dari pengguna bogui.exe ini
dapat dicari melalui Target Host Port
di sebelah kiri atas.

Mencari korban
Ketikkan kelompok IP address di sini,
misalnya 127.0.0.* akan men-scan apa-
kah ada komputer dengan IP address
ini yang telah terinfeksi oleh boserve.
exe. Perintah yang dapat dijalankan
pada komputer itu termasuk File Delete!

Download BO.ZIP
Download bo.zip dari situs Cult of the
Dead Cow yang tampak pada gambar:
www.cultdeadcow.com/tools/bo.html
Selain itu bo.zip dapat pula diperoleh
di situs-situs hacking lainnya seperti
http://users.pandora.be/t-mp3/bo/
download.html

Unzip BO.ZIP
Gunakan Winzip untuk mengekstrak
bo.zip yang terdiri dari komponen
utama: boserve.exe, bogui.exe,
boclient.exe, dan boconfig.exe. Selain
itu terdapat utilitas lain dan manual
penggunaan BO serta pembuatan BO
Plugin.

1

5 6

2
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Artikel ini merupakan tips  sederhana
yang bermanfaat bagi pembaca dalam
menghadapai serangan virus makro
pada aplikasi MS. Word. Sebenarnya
ada cara singkat dalam mengatasi
serangan virus makro tersebut, seperti
menghapus file nnoorrmmaall..ddoott di dalam
harddisk, tetapi bukan jaminan virus
makro sudah hilang. Kadang virus
makro masih tersimpan di dalam data
kita atau malah menggandakan diri
dengan membuat file template lain
yang tidak kita ketahui.

Tindakan yang paling utama adalah
membersihkannya dengan anti virus
seperti Norton Anti Virus, McAfee,
Anti Viral Toolkit dan sebagainya. Ada
pepatah umum mengatakan “Mence-
gah lebih baik daripada mengobati,”
artinya ada beberapa trik handal de-
ngan bekal cukup pengalaman menjadi
programmer BASIC atau VISUAL
BASIC, anda dapat membuatnya
sendiri. Bagaimana?  Microsoft dalam
membuat aplikasi MS.Office (seperti :
Word, Excel, Powerpoint dan Access)
menyertakan juga bahasa pemrogram-
annya, yaitu Visual Basic Application
atau Visual Basic Editor, komponen ini
sebenarnya dapat di pilih saat instalasi
paket Microsoft Office tersebut.

Dalam kesempatan ini penulis telah
membuatkan Source Code Program
Anti Virus Makro untuk aplikasi Word,
pada percobaannya ternyata virus ini
cukup ampuh juga dalam mengenali

dan menghapus virus makro, semacam
CAP, Bandung, Ethan, Marker, BPPHCK,
JonMMX, Offshore Engineering, Dora
Emon, Titasic, Cyberhack, dan sebagai-
nya bahkan mungkin virus makro
yang tidak dikenal sekalipun. Listing
anti virus makro tersebut dapat anda
download dari situs NeoTek
(wwwwww..nneeootteekk..ccoo..iidd) lewat menu
‘Download’ atau Indo IT Center
(wwwwww..iinnddooiitt..nneett). Anda 

Source Code anti Virus Makro ini prin-
sip dasar kerjanya sama dengan virus
makro umumnya, yaitu dengan me-
numpangi file normal.dot (yang bersih
virus), file tersebut terbentuk pada saat
Aplikasi Ms Word 4.3/9x/2K dibuka
pertama kali. Source Code VBA Anti
Makro ini akan berada di dalam file
normal.dot, selain itu VBA Script ini
membuat duplikasi template file dari
normal.dot dengan nama jayawiguna.
dot, setiap virus makro yang tidak
dikenali bahkan tidak dapat dibersihkan
pun, akan diubah nama datanya men-
jadi file jayawiguna.doc (dijamin bersih
dari serangan virus makro), sedangkan
file yang terinfeksi virus tadi langsung
dihapus, kemudian file jayawiguna.doc
tersebut sebagai data anda yang baru
dan bersih dari virus serta sama dengan
data asal anda.

Berikut ini tatacara penggunaan VBA
Script Anti Makro khusus di program
pada Ms.Word 97/2K:

•Hapus terlebih dahulu file
normal.dot anda

• Jalankan Program MS Word 97/2000
•Klik Tools,Macro
•Pilih Visual Basic Editor, atau tekan

Alt+F11
•Pada Item Project, Klik  item normal

dengan Button kanan mouse
•Akan tampil menu pop-up , Pilih

Insert, module
•Muncul jendela untuk membuat

script program
•Copy-lah Text File VBA SCRIPT

tersebut
•Paste text Pada jendela module
•Klik kanan module pada item Project
•Pada menu pop-up, pilih properties
•Pilih Protection, centang pilihan lock

project for viewing
•Isilah password dan konfirmasinya
•Simpanlah perubahan tersebut.
•Tutup dan keluar dari MS Word 
•Buka kembali Aplikasi MS Word
•Pada jendela MS Word khususnya

pada caption kiri atas, akan tampil
tulisan 'Document1-Microsoft Word
- Protected by Jaya Wiguna Anti
Macro'

Buat Toolbar pembersihnya dengan cara:

•Dari menu Tools, pilih Customize
•Pada item Command
•Pilih Macros
•Drag perintah-perintah dalam

Command, seperti : normal.FJW.Bck
dan normal.FJW.Et_  tempatkan pada
toolbar menu.

Foryanto J. Wiguna mencoba membantu anda ‘menembak’ dua jenis virus yang sering
membuat orang kewalahan. Anti virus makro dibuat dengan editor Visual Basic, sedangkan Trojan

Horse dibasmi dengan utilitas yang dapat diperoleh dari Internet atau secara manual.

Virus MakrVirus Makroo && TTrrojan Horseojan Horse
Berduel denganBerduel dengan

Anti Virus MakroAnti Virus Makro
Bayangkan jika anda menghadapi si-
tuasi kerja seperti yang berikut ini.
Pagi hari anda mulai menghidupkan
PC, menyalakan modem untuk mela-
kukan koneksi ke Internet serta meme-
riksa apakah ada email baru yang ma-
suk ke dalam ‘Inbox’ anda, sambil
menjelajahi ke beberapa situs favorit
untuk mencari informasi baru seputar
dunia komputer, teknologi informasi
dan berita perkembangan lainnya yang
terbaru saat ini.

Secara tiba-tiba layar monitor berubah
menjadi screensaver ketika anda ting-
gal sebentar untuk menyeduh secang-
kir kopi panas. Ketika kembali, screen
saver menanyakan password. Padahal
anda tahu bahwa anda tidak mengubah
tampilan desktop dan wallpaper-nya.
Anda jadi makin bertanya-tanya, ada
yang aneh dan tidak beres. Billing In-
ternet terakhir anda juga malah mem-
bengkak sampai lebih dari dua kali li-
pat, padahal hanya anda yang meng-
akses Internet, dan anda berkeyakinan
penuh bahwa password  account anda
benar-benar aman. Anda telah melaku-
kan semua yang disarankan oleh para
ahli. Anda tidak menuliskan password
anda pada selembar kertas yang anda
taruh di dalam dompet, anda tidak
memberitahukan password tersebut ke
seorang teman atau pada siapa pun dan
anda memilih password huruf acak yang
tidak mungkin tertebak menurut anda.
Pikiran anda secara otomatis tersam-
bung ke Serial TV ‘La Femme Nikita’
yang semalam  anda tonton, ada kekuat-
an di luar kontrol yang melakukan ini.

Anda salah dan keliru. Tidak ada se-

orang pun yang mengubah
tampilan desktop dan
wallpaper komputer anda.
Tidak ada makhluk tak
nyata yang menghabiskan
jatah Internet anda.
Komputer anda telah
disisipi ttrroojjaann  hhoorrssee oleh
orang-orang yang tidak
bertanggung-jawab
(cracker), orang-orang
yang senang menganggu
orang lain dan menikmati
kesenangan dari
kebingungan orang lain.
Mereka adalah orang-
orang yang merasa hebat
karena mampu mencuri
password account Internet
anda dengan cara ini yang
bahkan anak berusia 15
tahun dengan pengetahuan
minim tentang keamanan

jaringan komputer pun mampu
melakukannya tanpa mengalami
kesulitan berarti.

Trojan  Horse, apa itu ? 
Trojan horse adalah sejenis program
yang melakukan aksi tidak sesuai de-
ngan yang diharapkan pengirim atau
pembuatnya. Sebagian orang menye-
butnya sebagai “virus yang tidak mirip
virus”, karena meskipun seringkali
merugikan, ia tidak memiliki karakter
utama virus. Ia tidak mampu menye-
barkan dirinya secara otomatis. Trojan
Horse bukanlah hal yang baru. Ia telah
ada bertahun-tahun yang lalu, tetapi
kemudian banyak disebut-sebut lagi
ketika suatu kelompok hacker yang
menamakan diri mereka Cult of the
Dead Cow (cDc) merilis program ber-
nama BBaacckk  OOrriiffiiccee  (BO) yang mereka
maksudkan sebagai program pengon-
trol jarak jauh (remote login). Program
ini, apabila berada di tangan orang yang
salah, dapat mengakibatkan kerusakan
fatal dan terburuk yang tidak dapat an-
da bayangkan. (Lihat lebih jauh ten-
tang penggunaan BO di hlm. 30-31.)

Setelah BO dirilis, banyak bermuncul-
an program sejenis. Yang paling terke-
nal selain BO adalah NetBus dan Deep
Throat. Jika BO hanya dapat dieksekusi
di bawah sistem operasi Windows 95/
97/98/ME, NetBus bahkan dapat dija-
lankan di Windows NT.

Intinya adalah bahwa Trojan Horse
adalah program yang melakukan tu-
gasnya secara sembunyi-sembunyi dan
tidak anda harapkan. Pengertian Trojan
Horse tidak terbatas pada program-

program pengontrol jarak jauh seperti
BO, NetBus dan Deep Throat. Sebagai
contoh, beberapa waktu lalu seseorang
yang tidak teridentifikasi telah memo-
difikasi paket program TCP Wrapper
buatan Wietsa Venema yang namanya
mencuat setelah merilis SATAN bersa-
ma dengan Dan Farmer dan kemudian
menyebarkannya pada server ftp pu-
blik. Jika seorang networker atau sys-
tem administrator men-download dan
memasang program ini pada server
UNIX mereka, si cracker dapat dengan
mudah menembus masuk ke sistem
server tanpa kesulitan berarti.

Cara BO dan program sejenisnya
bekerja
BO terdiri dari dua program utama,
yang pertama disebut sebagai sseerrvveerr
dan yang lainya sebagai cclliieenntt. Pro-
gram server BO kemudian disebarkan
ke seluruh dunia melalui email, mail-
ing list, newsgroup, IRC, dan server
FTP publik. Ketika seseorang menja-
lankannya, program ini secara otomatis
menempelkan dirinya pada registry
Windows dan umumnya menghapus
dirinya sendiri (Deep Throat tidak me-
akukannya). Selanjutnya ia akan selalu
aktif saat anda menghidupkan kom-
puter dan menjalankan windows. He-
batnya, program ini tidak terdaftar
dalam “Active Task” saat anda mene-
kan Ctrl-Alt-Del, jadi anda mungkin
tidak akan pernah curiga bahwa sesua-
tu yang ilegal sedang bekerja di bela-
kang layar, coba anda periksa dulu file
win.ini! 

Saat aktif, server BO membuka suatu
port yang dapat dihubungi oleh client-
nya (dalam hal ini, si cracker). Si
cracker kemudian menjalankan client-
nya untuk mengobok-obok PC Anda.
Untuk dapat melakukannya, ia perlu
mengetahui IP Adress anda (sekedar
informasi bagi anda yang mungkin
awam mengenai jaringan komputer, IP
Address adalah pemberian alamat unik
4 byte (32 bit) yang pasti dimiliki oleh
host yang terhubung ke jaringan pro-
tokol TCP/IP, termasuk jaringan Inter-
net). Jika anda mengakses Internet de-
ngan dial-up menggunakan modem
telepon, seperti yang dilakukan oleh
kebanyakan dari kita, anda akan diberi
IP Address dinamik (DHCP), yang
selalu berubahse tiap kali anda meng-
hubungkan PC anda ke Internet.

Pertanyaan yang muncul adalah jika
kita mendapatkan IP Address dinamik,
bagaimana mungkin si cracker meng-
akses PC kita, karena IP Address kita

TTrojan Horserojan Horse



JABOTABEK

WILAYAH PUSAT
•Hayam Wuruk Agency

(Sebelah bengkel Honda)
Jl. Pramuka Raya No .46
Tel. 021-8566578
Fax. 021-8566578

WILAYAH TIMUR/BEKASI
•Duta Harapan Agency

Perum Data Harapan
Jl. Duta Utama III
Blok AB I No.6, Bekasi
021-8880707

•Mega Media Agency
Ruko Blok B No.9
Kawasan MM 2100
Cibitung
021-8980338/9

•Nusa Indah Agency
Perum Villa Nusa Indah
Blok FIII No.8, Bojong Kulur,
Gunung Putri, Bogor
021-88961044

•New Nusa Agency
Kompleks Central Niaga
Kalimalang Blok A.3
Cibitung
Tel. 021-88961044
Fax. 021-88961045

•Mekar Indah Agency
Perum Cikarang Baru
Jl. Puspa X No. 26
Cikarang, Lemah Abang
021-8937020

•Cileungsi Indah Agency
Perum Citra Indah
Jl.Agape VI Blok A.8 No. 50
Jonggol-Bekasi
021-89931264

•Rafles Indah Agency
Perum Kranggan Permai,
Blok AS 14 No. 31
Kranggan, Jati S
021-88961044

• Karawang Indah Agency
Perum Karaba Indah
Blok H No. 47, Johar
Karawang
0267-643205

• Bukit Indah Agency
Jl Raya Cikopo Km. 13
Cempaka Purwakarta
(Depan PT.Indofood  Cikopo)
0264-319363

•Anggrek Agency
Taman Harapan Baru
Blok N 4 No.23
021-88979577

WILAYAH BARAT
•Adiyasa Agency

Taman Adiyasa Blok J 20/25
Cikupa. 021-59761083

•Bumi Permai Bintaro Jaya
Sektor VII Blok P 88
Tel. 021-5372754
Fax. 021-5388384

•Cilegon Agency
Ruko Istana Cilegon Blok C/11
Cilegon. 0254-380712

•Grand City Agency
Citra Raya Blok D6/26
021-5962050

• Jaya Utama Agency
Jl. Peta Barat No 1
Kalideres

•Niaga Cinere Agency
Ruko Griya II Blok A1/9
Cinere. 021-7547549

•Pamila Agency
Pamulang Villa Blok DB 4/7
Pamulang. 021-74444934

•Serpong Agency
Ruko Gading Serpong
Blok AF 1/9. 021-5467101

WILAYAH SELATAN
•Langlang Buana Agency

Taman Pagelaran Blok T5/30
Ciomas, Bogor
0251-5467101

•Garsegor Agency
Jl Kedung Halang Talang 152
Bogor
Tel. 0251-656569
Fax. 0251-660787

•Garsemi Agency
Jl Sriwedari No.80
Sukabumi. 0266-221438

•Sentul Indah
Jl Raya Babakan Madang
Rt 4/02 Citeureup
021-87951185

•Nirwana Agency
Jl Kedung HalangTalang 168
Bogor. 0251-663302

LUAR JABOTABEK

Bandung
•Antapani Agency

Jl Batik Kumeli No. 52
Bandung 40123
022-2515115

•Sangkuriang Agency
Jl Sindangkasih No.19
Perum Antasari, Bandung
022-7203750

•Sangkuriang Agency
Jl. Budisari I No.24
022-2045210
Bandung 

•Utama Agency
Pojok Tengah I RT 03/RW06
Kel. Setianama
Kec. Cimahi Tengah
022-6610811

•Abimanyu Agency
Komp. Griya Bandung
Indah, Ciwastra
Jl Pesona Alam V
C15 No. 17
022-7532181

WILAYAH JAWA TIMUR
•Permata Agency

Jl Basuki Rahmat No. 93
Surabaya
Telp. 031-5454691, 322938
Fax. 031-5342482

• Intan Agency
Jl Basuki Rahmat No. 93
Surabaya
Telp. 031-5454691, 322938
Fax. 031-5342482

•Berlian Agency
Taman Sulfat III No. 16
Malang
0341-484884

•Zamrud Agency
Jl. Wahid Hasyim No.8
Bandar, Kediri
0354-772056

• Jl P.B. Sudirman 118 
Jember
0331-483383

• Jasawarta Agency
Jl. S. Parman No. 46
Madiun
0351-458705

WILAYAH JAWA TENGAH
•Raja & Fokus Agency

Jl. Menteri Supeno No. 30
Semarang
Telp. 024-8453848
Fax. 024-8453848

•Korma Agency
Jl RA Kartini No. 67 B
Pekalongan
0285-413918

•Menara Kudus
Jl. Nganggok Wali No. 243
Kudus

•Basis Agency
Jl. Osamaliki No. 8
Salatiga

•Bengawan Agency
Jl. Honggowongso No. 140
Solo
Telp. 0271-721151
Fax. 0271-721151

WILAYAH YOGYAKARTA
•New KGB Agency

Jl. Suroto No. 2 A
Kotabaru, Yogyakarta
Telp. 0274-518267
Fax. 0274-518267

•Lia Agency
Jl. Suroto No. 2 A
Kotabaru, Yogyakarta
Telp. 0274-518267
Fax. 0274-518267

Wilayah Palembang
•Musi & Ampera Agency

Jl. Jend.Sudirman No. 1033
H Palembang. 0711-362120

Wilayah Medan
•Berdikari Agency

Jl KH Wahid Hasyim No.37
Medan
Tel. 061-4144167
Fax. 061-4144167

Lampung
•Lampung Jaya Agency

Jl. A. Yani No. 48
Tj. Karang Lampung
Tel. 0721-255696
Fax. 0721-255696

Batam
•Otorita Agency

Komp. Regency Park
Blok IV/51
Jl Teuku Umar, Batam
Tel. 0778-450452
Fax. 0778-450452

Makassar
•Selayang Pandang

Jl Mesjid Raya No. 49
Makassar
Tel. 0411-321907
Fax. 0411-321907

•Pare-Pare
Jl.Abdul Rasyid No. 7
Pare-Pare
0421-22521

Denpasar
•Prima Agency

Jl. Gatot Subroto
No. 100X Kav. 9
Denpasar, Bali
Tel. 0361-241433
Fax. 0361-262856
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selalu berubah-ubah? Jawabnya: si
cracker memiliki program tambahan
yang disebut sebagai “PlugIn”, yang
memungkinkan ia melakukan scanning
terharap range IP tertentu, untuk
melihat PC (istilah yang lebih tepat
adalah host, bukan PC, toh sangat
mungkin jika di antara anda ada yang
menggunakan Macintosh untuk meng-
akses Internet, bukan PC. Istilah PC
digunakan agar tidak membingungkan)
mana saja yang telah disusupi. Jika ia
ingin mengakses harddisk contoh saja
pelanggan provider Bonet (yang sangat
mungkin berarti bahwa ia tertarik un-
tuk mengakses Internet dengan meng-
gunakan Bonet via account anda), ia
akan melakukan scanning pada IP
Address 202.159.32.1 hingga
202.159.255.254, Si cracker mungkin
telah memiliki daftar IP Address untuk
provider yang ada. Jika tidak, dengan
sedikit usaha, ia akan mendapatkannya.

Ketika ia telah berhasil menghubung-
kan clientnya ke PC anda, si cracker
dapat berbuat apa saja yang ia sukai.
Coba pikirkanlah apa yang dapat anda
lakukan dengan PC anda, ia dapat me-
lakukan hal yang sama dengan berba-
gai keterbatasan tertentu. Anda dapat
memutar lagu berformat MP3, ia juga
dapat melakukannya untuk Anda. Ha-
nya saja, ia tidak dapat mendengar lagu
tersebut, karena speaker-nya terpasang
di ruangan anda. Anda bisa saja salah
menghapus beberapa file, ia dapat se-
ngaja menformat harddisk anda. Anda
dapat menyimpan nomor rekening dan
identitas anda dalam dokumen yang
anda ketik menggunakan Microsoft
Word dan dilindungi dengan password,
si cracker dapat meng-copy-nya ke
harddisk lokal miliknya dan meng-
crack password serta mengubahnya
dalam waktu kurang dari 5 menit.

Cara Mendeteksi BO dan Rekan-
Rekannya 
Bagaimana cara si client dapat meng-
hubungi si server? Hingga saat news-
letter ini ditulis, tidak ada cara lain ke-
cuali melalui port yang sudah dibuka
secara diam-diam oleh si server. BO
secara default menggunakan port
31337 untuk berhubungan. NetBus
menggunakan port 12345 dan 12346,
sedangkan Deep Throat menggunakan
port 2140 dan 3150.

Gunakan utility default Netstat bawa-
an dari Windows untuk memeriksa
port apa saja yang terbuka pada PC
anda. Dari DOS prompt, ketikkan
“netstat -an”. Jika terlihat port-port
yang disebut di atas terbuka atau da-
lam keadaan aktif, hampir bisa dipas-
tikan bahwa PC anda ditempeli trojan

horse. Hasilnya kurang lebih seperti ini
(hasilnya mungkin tidak akan sama
untuk PC yang berbeda):

Active Connections
Proto Local Address Foreign
Address State
UDP 192.168.0.1:137 *:*
UDP 192.168.0.1:138 *:*

Utility netstat juga tersedia di ling-
kungan UNIX, sebagai salah satu uti-
litas jaringan yang tangguh. Hanya sa-
ja, pengguna UNIX (termasuk Linux
dan FreeBSD) tidak perlu khawatir ter-
infeksi oleh trojan horse ini. Jika PC
yang terinfeksi BO, misalnya, perintah
“netstat -an” akan memberi hasil
kurang lebih seperti berikut:

Active Connections
Proto Local Address Foreign
Address State
UDP 192.168.0.1:137 *:*
UDP 192.168.0.1:138 *:*
UDP 192.168.0.1:31337 *:*

Dalam hal ini, Anda tidak perlu khawa-
tir dengan port 137 dan 138 yang ter-
buka pada PC Anda, seperti dilaporkan
netstat. Port tersebut adalah port de-
fault untuk protokol SMB yang digu-
nakan oleh Windows. Kami menggu-
nakan frasa “dalam hal ini” pada para-
graf di atas, karena pada situasi terten-
tu, port ini—jika terbuka—dapat ber-
bahaya, tetapi pembahasan mengenai
hal itu di luar jangkauan artikel ini.

Tiba waktunya: bantai mereka
semua! 
Kini tibalah waktunya anda mengha-
pus trojan horse yang telah mengang-
gu anda selama ini. Cara paling praktis
untuk melakukan hal ini adalah dengan
menggunakan utilitas khusus yang di-
rancang untuk menghapus mereka. Pe-
nulis tidak akan merekomendasikan
suatu program “super trojan horse
remover” yang dapat menangani se-
mua masalah anda sehubungan dengan
trojan horse. Menurut pengamatan pe-
nulis belum pernah ada program se-
perti itu. Anda dapat mencari di Inter-
net dengan bantuan mesin pencari,
seperti Excite (www.excite.com), Lycos
(www.lycos.com), Altavista (www
.altavista.com), Yahoo (www.yahoo.
com), Google (www.google.com) atau
mesin pencarilain. Gunakan keyword
“NetBus remover,” “BO remover,”
atau “Deep Throat Remover.”

Anda dapat melakukannya secara ma-
nual, tetapi ini dapat membahayakan
kelangsungan hidup Windows anda,
karena anda perlu mengedit file regis-
try anda. Untuk itu ikuti beberapa tips
berikut:

UUnnttuukk  BBOO
•Hapus file .exe (ya, tidak ada karakter

sebelum tanda titik) dan windll.dll
yang terletak di \windows\system 

• Jalankan program “regedit” (Hati-
hati! atau anda perlu menginstall
ulang Windows Anda!).

•Cari kunci HKEY_LOCAL_
MACHINE\SOFTWARE\ Micro-
soft\Windows\CurrentVersion\Run
dan hapuslah kunci yang merujuk ke
“.exe”

•Boot PC anda. Selesai.

UUnnttuukk  NNeettBBuuss
•Cari program server NetBus yang

default-nya adalah “patch.exe”, dan
hapuslah. Anda perlu mencarinya pa-
da registry Windows anda. Jadi guna-
kanlah “regedit.”

•Setelah dihapus, cari kunci
HKEY_LOCAL_MACHINE\SOFT
WARE\Microsoft\ Windows\
CurrentVersion\Run 

•Cari file “.exe” dan tambahkan
parameter “/remove.”

•Boot PC anda. Selesai.

UUnnttuukk  DDeeaapp  TThhrrooaatt
•Temukan file “systempatch.exe”

dalam harddisk anda—jika nama file-
nya belum diganti oleh si cracker.

• Jalankan “regedit.” Cari kunci
HKEY_LOCAL_MACHINE/SOFT
WARE/WINDOWS
/CURRENTVERSION/RUN dan
hapus nilainya.

•Boot PC anda. Selesai.

*) Foryanto J. Wiguna adalah salah satu
pemerhati di dunia Teknologi Informasi,
Aktivitas sebagai Konsultan TI di
SITUSBOGOR.COM, serta Ketua Yayasan
Masyarakat Teknologi Mandiri (Karya
COMTECH) Bogor.
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NeoSearchNeoSearch

data yang dimiliki salah satu pelo-
por mesin pencari di Internet ini
dengan 1,3 milyar halaman Web
(Web page) yang telah diindeks oleh
Google sendiri.

Fasilitas baru
Keberhasilan Google memenangkan
persaingan dalam kancah perang
mesin pencari tidak lantas membuat
Google berpuas diri.

Seperti yang dapat anda baca di ha-
laman ini, Google menambahkan
beberapa fasilitas baru yang tentu-
nya diharapkan dapat membantu
anda ketika berupaya menemukan

informasi di Internet. Fasilitas itu di
antaranya adalah Google Ringkas,
Google Image, dan Google Univer-
sity Search dan Google Advanced
Search.

aat ini Google (wwwwww..
ggooooggllee..ccoomm) telah menjadi
mesin pencari (search

engine) terpopuler. Penampilannya
yang ‘bersih’—tanpa embel-embel
banner—damn kerjanya yang cepat
telah menjadikan mesin pencari ini
menjadi pilihan pertama orang
sebagai ‘pintu masuk’ ke dunia
maya.

Keunggulan Google terbukti yaitu
ketika mesin pencari lain gulung
tikar, Google malah makin berkibar.
Google pun kemudian mengakuisisi
situs mesin pencari lain yaitu Deja
untuk kemudian menyatukan basis

MMEENNGGEENAL LENAL LEBBIIH JH JAUAUHH
FFUUNNGGSSII
GOGOOOGGLELE
Google mengembangkan beberapa fungsi tambahan yang
mendukung fungsi dasar Google sebagai mesin pencari.

S

Google Image Search
http://images.google.com/

Anda dapat mencari gambar atau image
lewat Google. Mesin pencari ini telah
mengindeks lebih dari 250 juta gambar.
Anda hanya perlu memasukkan kata
kunci gari gambar yang anda cari.

Pencarian: Indonesia
Inilah salah satu hasil pencarian
gambar ketika dimasukkan kata kunci
‘Indonesia.’ Pencarian mendapatkan
sekitar 1.380 gambar yang berkaitan
dengan Indonesia.

Google Ringkas
www.google.com/ie

Pencarian lewat halaman ini akan
memberikan hasil yang ringkas, tetapi
lebih cepat. Di layar komputer hanya
akan muncul logo Google dan kotak
pencarian. Masukkan kata kunci yang
perlu anda cari, lalu tekan ‘Enter.’

Hasil Pencarian
Ketika dimasukkan kata kunci ‘Diction-
ary,’ hanya dalam beberapa detik Google
menyajikan hasil pencarian, tanpa kete-
rangan apa pun. Tetapi jika anda me-
nempatkan kursor beberapa lama di
atas suatu link, akan muncul keterang-
an tentang situs bersangkutan.

1
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Google Advanced Search
www.google.com/advanced_searchhtml

Google juga menyediakan pencarian
tingkat lanjut dengan alamat di atas.
Cara pencarian yang mirip dengan
metode Boolean ini diberikan agar
anda tidak perlu menghapalkan ‘rumus’
rumit dalam pencarian.

Exact Phrase
Gambar di atas adalah hasil pencarian
dengan fasilitas ‘with the exact phrase’
untuk ‘Indonesian history.’ Dengan cara
ini, Google hanya mencari dokumen
Web yang mengandung frasa yang
dimasukkan.

Google University Search
www.google.com/options/universities.
html

Dengan opsi di atas anda dapat mem-
persempit pencarian hanya untuk situs
universitas tertentu, sedangkan di
bagian bawah terdapat daftar nama
universitas, disusun secara alfabetis.

Mendaftarkan Kampus Anda
www.google.com/options/mycampus.
html

Jika anda webmaster situs kampus anda
dan ingin universitas anda tercantum
pada fasilitas Google ini, anda dapat
mendaftarkannya pada alamat di atas.

3
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Search engine Pro-
gram yang mencari dokumen
berdasarkan kata kunci (key-
word) tertentu, lalu menyajikan hasil pencarian
sebagai suatu daftar dari dokumen-dokumen
yang ditemukan mengandung kata kunci
dimaksud.

Keyword Kata yang digunakan dalam
suatu pencarian, misalnya, untuk
menemukan dokumen Web yang berkaitan
dengan subjek tertentu.

DDAFAFTTARAR
IISSTTIILLAHAH

MMARARI KI KITITAA
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Goolge Ringkas
Jika anda ingin mendapatkan hasil
yang cepat tanpa direpoti banyak

teks, gunakan fasilitas ini di alamat
www.google.com/ie.

!

Tidak Direpotkan Boolean
Anda enggan menghapal kombi-
nasi logika Boolean yang memang

tidak diterima Google? Gunakan fasi-
litas Google Advanced Search di
alamat www.google.com/advanced_
searchhtml.

!

Memanfaatkan fasilitas yang disediakan Google

MENCARI
DENGAN TOPIK?

Dapat ditemukan di
Google Web Directory di
http://directory.google.com
Direktori Web ala Google
menggolongkan situs ber-
dasarkan topik tertentu,
misal, Arts, Business,
Computers, dsb.

MENCARI
ALAMAT DI AS?

Gunakan fasilitas white
pages Google. Di kotak
pencarian, masukkan
nama orang atau perusa-
haan yang dicari ditam-
bah nama kota dan
negara bagiannya.

MENCARI
NEWSGROUP?

Gunakan Google Groups
di http://groups.google.com
Masukkan kata kunci
‘masyarakat,’ maka akan
disajikan 18.900 group
yang berkaitan dengan
kata ini.

NO WILD CARD,
PLEASE1

Jangan menggunakan
karakter bintang (wild
card) dalam pencarian di
Google. ‘Computer’ dan
‘computers’ dianggap dua
kata berbeda oleh
Google.

NO STOP WORDS,
PLEASE2

Tidak perlu menggunakan
kata tengah (stop words),
seperti ‘and,’ ‘the,’ dan
‘how’ di Google. Gunakan
karakter ‘+’ untuk me-
nyertakan suatu kata
dalam pencarian.

NO NEED OF
CAPITALS3

Huruf besar (kapital) dan
huruf kecil (biasa)
diperlakukan sama.
Memasukkan ‘George
Bush’ sama dengan jika
anda mengetikkan
‘geOrGe BuSh.’

‘OR’ IS WELCOME4
Jika ‘AND’ tidak diindah-
kan Google, ‘OR’ diperla-
kukan sebaliknya. Guna-
kan ‘OR” untuk melakukan
pencarian ‘ini atau ini.’
Misal, ‘history jakarta OR
bandung.’
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3 Getting started

Pada menu tree di bagian kiri, ada
simbol-simbol: agents,
directories,        dokumen yang
akan di-download,        dan
dokumen yang telah di-download
(html, zip, sound, dll.) 

NeoSearchNeoSearch

halaman Web, mencari teks, men-
downbload link-link web yang dipi-
lih dan masih banyak lagi.

Dengan menggunakan eCatch, anda
dapat mem-browse Internet dengan
cara yang baru sama sekali. Jika
sebelumnya anda mencari informasi
dengan cara melompat dari satu
halaman ke halaman lain sehingga
menghabiskan waktu dan membuat
pulsa membengkak, maka sekarang
dengan eCatch anda dapat menghe-
mat pulsa anda. Ini dimungkinkan
karena eCatch membantu anda
untuk mem-browse secara offline
dengan cara men-download seluruh

halaman, gambar dan link-link
terlebih dahulu ke hard disk anda.
Kemudian pada saat anda membaca
secara offline, eCatch akan me-
refresh halaman Web itu dan me-
nandai bagian mana yang telah di-

update oleh server situs tersebut.

Anda sekarang bisa membuat basis
data dokumen pribadi dan eCatch
akan meng-update isinya dan
memberitahu jika ada yang baru.

ada NeoTek Vol. I, No. 9, Juni
2001 kami pernah menyajikan
sebuah program bernama ZipUp

the Web. Program ini memungkinkan
anda menyalin (copy)  isi suatu situs Web
sehingga anda dapat melakukan apa yang
disebut offline browsing.

Mirip dengan ZipUp the Web, ada sebuah
program bernama eCatch yang juga me-
mungkinkan anda melakukan hal yang
sama. Selain untuk offline browsing,
eCatch dapat digunakan untuk survei se-
perti update, search dan perbandingan
antar halaman. eCatch memungkinkan
anda mengisi suatu formulir secara off
line, meng-highlight perubahan pada

OOFFFFLILINNE BE BRROOWWSSIINNGG
DDEENNGGAN AN 
eeCACATTCCH 3.0H 3.0
Browsing, selain dapat dilakukan secara online, juga bisa
secara offline. Salah satu program yang memungkinkan
anda melakukan offline browsing adalah eCatch.

P

Depth level 
Untuk men-download seluruh
halaman, anda harus menyetel
berapa kedalaman link dari situs
yang akan di-download. Untuk itu
setel menu Depth level dari Pro-
perties. Pilih jumlah depth level ini
di kotak Download depth level.

Information view
Setiap informasi situs yang akan
atau telah di-download dapat
anda lihat di menu View>Inform-
ation view. Informasi ini berisi
Status, Links, Properties,  dan
Communication.

Men-download eCatch
Download eCatch dari
www.ecatch.com/download.htm
Selanjutnya, seperti biasa, anda
harus menginstal program ini di
komputer anda.

Instal eCatch
Instal eCatch dengan mengikuti
petunjuk yang diberikan. Setelah
instalasi program selesai, akan
muncul window seperti pada
gambar di atas.

1
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Proses download
Jika anda perhatikan bagian tree
menu, akan terlihat proses
download untuk semua link
secara bersamaan. Terlihat bah-
wa eCatch mampu melakukan
download situs-situs secara
cepat dan paralel. 

Informasi hasil download
Untuk melihat hasil download,
klik salah satu file, misal html
lalu klik Information view. Anda
bisa mengetahui kapan suatu
halaman web di-update dengan
melihat  tanggal  pada kolom
Last modified.

Search
Dengan eCatch, anda dapat men-
cari file-file di Internet dengan
mudah karena adanya fasilitas
multi-search engine yang terdiri
dari 10 search engine. Search
engine itu antara lain Altavista,
Yahoo, Lycos, dan Euroseek. 

Preferences: Main Options
Sebelum anda gunakan, cek ter-
lebih dahulu ‘Preferences’ de-
ngan meng-klik File>Preferences
>Main. Di window ini anda da-
pat mengeset Connection, Down-
load, Highlighting, Miscellaneous,
dan Profile.

4

10 11

5

OOfffflliinnee  BBrroowwssiinngg
Pencarian halaman Web tanpa
harus terkoneksi ke Internet.
Hal ini dimungkinkan jika anda telah men-
download seluruh isi suatu situs secara
keseluruhan beserta link-link yang ada. Untuk itu
diperlukan program khusus seperti Zip Up The
Web dan eCatch.

LLiinnkk Rujukan ke suatu dokumen lain. Link
semacam ini kadang disebut hot link karena
mengantarkan anda ke dokumen lain ketika
anda mengkliknya.

DDAFAFTTARAR
IISSTTIILLAHAH
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Mengaktifkan satu agent
Untuk memilih salah satu agent
saja yang bekerja, klik menu Edit
> Deactive. Dengan demikian,
anda masih bisa membuka agent
yang lain tetapi agent tersebut
tidak men-download. 

!

Penggunaan eCatch 3.0

List view
Setelah terkoneksi ke Internet, klik
menu Connect. Sekarang file yang
akan di-download, segera diproses
seperti terlihat pada gambar.
eCatch secara otomatis akan
membuat list yang terdiri dari file
dari situs yang akan di-download.

9

Membuat New Address
Untuk memasukkan sebuah ala-
mat baru ke dalam salah satu di-
rektori ‘Smart address,’ klik File>
New Address. Selanjutnya akan
muncul window ‘Properties.’ Di
sini anda harus memasukkan
alamat situs pada kotak URL.

6

Membuat Agent baru
Anda juga bisa membuat agen
baru khusus untuk situs-situs pi-
lihan anda dengan mengklik File
>New agent. Pada window Create
an agent, pilih Starting point.
Anda bisa mengimpor situs-situs
yang ada di Favorites IE.

12
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masih terdapat banyak fungsi yang
dapat kita gunakan, seperti
penggunaan script, pelindung
terhadap pengguna “iseng” ataupun
men-download file MP3. Sekarang
saatnya anda lebih mengerti tentang
kelebihan mIRC, bukan hanya un-
tuk ber-chatting saja tapi juga harus
bisa berchatting dengan santai.

mIRC dapat anda download dari
situsnya yang beralamat di
wwwwww..mmiirrcc..ccoomm//mmiirrcc..hhttmmll. Program
ini merupakan program shareware
sehingga jika anda ingin terus
menggunakannya, anda harus
membayar.

IRC adalah program klien
IRC untuk Windows. Se-
perti pernah dibahas secara

panjang lebar pada NeoTek Vol. I,No.
8, Mei 2001, mIRC adalah program
yang memungkinkan penggunanya
berkomunikasi—ngobrol atau
chatting—dengan pengguna lain
tanpa batasan waktu dan jarak.
mIRC sudah merupakan “makanan”
bagi para netter, khususnya bagi
para remaja (ABG), yang doyan
gosip atau senang bergaul. Pada
edisi NeoTek Vol I,No. 2, November
2000 sudah dijelaskan cara penggu-
naan mIRC secara mendasar, tetapi
sebenarnya di dalam mIRC itu

LELEBBIIH JH JAUAUH DH DEENNGGANAN
mmIIRRCC
Ada beberapa fitur pada program mIRC yang sebenarnya
berguna, tetapi mungkin belum banyak diketahui anda yang
menggunakannya.

m

Menyalin teks
Kadang anda mungkin ingin meng-
gunakan teks dari teman ngobrol
anda namun anda malas menge-
tik ulang teks tersebut. Anda ting-
gal menyorot (highlight) teks yang
anda inginkan dan secara otoma-
tis teks tersebut sudah ter-copy.

Paste Text
Setelah menyalin teks tersebut,
jika anda ingin menggunakannya
anda tinggal mengklik kanan
tombol mouse anda pada ‘Text
bar,’ lalu klik ‘Paste.’ Maka teks
tersebut sudah tersedia tanpa
anda perlu mengetikannya ulang.

Mengubah warna
Pada mIRC kita dapat mengubah
warna teks yang akan kita tam-
pilkan. Tekan Ctrl+K, maka akan
muncul ‘Color index box.’ Anda
tinggal memilih warna yang di-
sediakan dari 0 sampai dengan 15.

Perlindungan Flood 1
Ketika anda ber-chatting, akan
sering terlihat teks yang diulang-
ulang sehingga layar chatting
anda terganggu. Untuk mencegah
hal ini ketik “/flood 350 20 3 30.”
Anda akan menerima 350 bytes
per 3 pengguna dan ignore time
30s.

1
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Chat Saling berkirim pe-
san secara langsung antara
seorang pengguna komputer
dengan seorang pengguna komputer lain
atau lebih. Setelah chat dimulai, pengguna
yang satu dapat mengirimkan teks dengan
mengetikkannya pada keyboard. Teks yang
dikirim akan muncul pada monitor komputer
dari pengguna yang menjadi teman ngobrol
atau chat itu.

Flood Pesan atau teks chat yang diulang
berkali kali oleh seorang chatter sehingga
membuat chat screen terkena lag.

Flooder Chatter iseng yang melakukan
repeating text lebih dari 3 kali sehingga
mengganggu sebuah chat room.

DDAFAFTTARAR
IISSTTIILLAHAH
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Script dan bot
Bila anda menjadi pengelola se-
buah chat room, ada baiknya
anda mencari sebuah script
protection atau bot yang dapat
menjaga ruang ngobrol anda.

!

DCC
Bila anda menerima sebuah
kiriman file ada baiknya anda
mengetahui jenis file dan siapa
pengirim file tersebut sebelum
anda menerimanya.

!

3 Perlindungan Flood 1
Atau anda bisa mengaktifkan
flood protection melalui File>
Options>IRC>Flood, lalu aktifkan
‘Enable flood protection.’ Dan
anda dapat menyetel flood
protection anda.

9 Identifier
Pada mIRC anda dapat melihat in-
formasi chatter lain, ISP yang digu-
nakan, siapakah dia, dan User ID-
nya. Klik tombol kanan mouse pa-
da salah satu nama chatter lalu pi-
lih ‘Whois.’ Atau anda bisa me-
ngetikkan “/whois <nickname>”
pada ‘Text bar.’

4 5 6
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Invisible Mode 1
Dalam ber-chatting ketika anda
akan memasuki sebuah chat
room, anda bisa terlihat ataupun
tidak terlihat. Untuk mengaktifkan
invisible mode ketik “/mode
<nickname anda)> +i” pada
status bar akan terlihat tanda (+i).

Invisible Mode 2
Anda juga dapat mengaktifkan
Invisible Mode melalui File>
Option>Connect. Setelah terlihat
menu ‘Connect,’ di bagian bawah
ada pilihan ‘Invisble mode.’
Aktifkan mode ini sebelum anda
tersambung dengan server.

Menangkap URL
Dalam mIRC sering terlihat suatu
alamat URL yang diketik oleh
chatter lain. Anda dapat me-
nangkap URL tersebut untuk di-
gunakan lain waktu. Pilih File>
Option>IRC>Catcher, lalu
aktifkan ‘Enable address catching
for URL’s.’

MP3 list
Anda sudah dapat mencari file
MP3 dari sebuah chat room.
Salah satunya adalah #indomp3
pada server DalNet. Ketik
@<Nickname> seorang chatter
untuk mendapatkan daftar file
MP3-nya.

File MP3
Jika anda sudah menemukan file
MP3 yang anda inginkan, ketik
“!<nickname> <nama file leng-
kap>” pada ‘Text bar.’ Silakan
tunggu beberapa saat sebelum
file ditransfer.

Script 
Selain mIRC versi original, juga
tersedia IRC dalam bentuk script
version (www.MIRCX.com) yang
mempunyai fungsi lebih seperti
Operator Command, Protection,
War Mode, Fun Mode, dan masih
banyak lagi.

Tip dan trik mIRC
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ALAUPUN KEDENGARANNYA
seperti sesuatu yang super
amat sangat canggih, tetapi

sebenarnya tidak ada yang terlalu wah
dalam hal penerapan prinsip-prinsip
arsitektur informasi pada situs anda,
dan anda pun tidak harus mempunyai
perangkat lunak yang fantastis atau
keterampilan khusus. Yang diperlukan
sebenarnya cuma pikiran yang terbuka,
sebentuk kerja keras, dan secuil
kesabaran.

Mengapa harus direncanakan?
Pada tingkatan yang paling dasar,
aarrssiitteekkttuurr  iinnffoorrmmaassii adalah proses pe-
ngumpulan informasi yang relevan
mengenai suatu situs dan analisis me-
ngenai bagaimana menambal lubang-
lubang kelemahannya sebelum anda
mulai membangun sebuah situs.

Dengan menggunakan arsitektur in-
formasi, anda dapat menemukan cara
yang paling efektif untuk menyajikan
isi situs anda serta membuat cetak biru
situs secara rinci, memberitahukan
anda mengenai berbagai macam hal:
tampilan, struktur, dan fungsi situs—
selain membantu anda membuat ren-
cana pengembangan situs di masa
datang.

Jika menurut anda ini merepotkan,
patut anda ingat bahwa situs yang

direncanakan dengan baik akan lebih
mudah diperbarui, lebih mudah diper-
baiki dan umumnya lebih berhasil
dibandingkan situs yang dibuat terge-
sa-gesa karena antusiasme berlebihan.

Tentukan tujuan anda
Tampaknya tujuan pembuatan situs
sudah cukup jelas, tetapi jika anda
belum memperoleh gambaran yang
jernih mengenai apa yang akan dila-

Terdengarnya mungkin di luar jangkauan kemampuan anda: mem-
buat situs Web yang hebat! Padahal kuncinya ada pada perencana-
an yang komprehensif dengan bantuan metode aarrssiitteekkttuurr  iinnffoorrmmaassii.

W

Situs yang Situs yang CiamikCiamik
MerencMerencanakananakan

kukan oleh situs anda, apa yang anda
harapkan akan dilakukan oleh para
pengunjung situs itu nantinya?

Letakkan diri anda dalam kerangka pi-
kir umumnya para peselancar. Mereka
biasanya hanya peduli akan dua hal—
tentang apakah situs itu dan apa guna
situs itu untuk dirinya. Jika situs anda
tidak dapat menjawab dua pertanyaan
tersebut dalam hitungan detik, maka
jangan terlalu terkejut jika tidak ada
orang yang menyambanginya.

Ajukan pertanyaan yang berikut
TTeennttaanngg  aappaakkaahh  ssiittuuss  tteerrsseebbuutt??
Jika anda tidak dapat menjawab perta-
nyaan ini secara langsung atau perlu
waktu 10 menit untuk menjelaskan-
nya, maka itu berarti anda harus mem-
pertimbangkan kembali rencana anda.
Tujuan situs anda harus jelas, feasible
dan fokus, sedangkan tema pokoknya,
idealnya, harus menarik dan unik.

Rencana anda harus realistis. Akan
jauh lebih baik jika anda mulai dengan
situs yang kecil, ramping, dan diperba-
rui secara regular, situs yang dapat me-
menuhi tujuannya sebagaimana yang
dicantumkan ketimbang situs yang
menjanjikan dunia tetapi yang muncul
hanya rumah keong.

Diskusikan gagasan anda dengan teman
dan kolega anda, lalu catat masukan
dari mereka, bahkan bila anda tidak
menyukai apa yang mereka katakan
sekalipun. Jika mereka beranggapan
gagasan anda payah, minta mereka
menjelaskan apa alasan mereka berkata
demikian dan lihatlah apakah mereka
dapat mengajukan  usulan untuk per-
baikan. Ujung-ujungnya anda sendiri
yang harus memutuskan. Jadi jika anda
yakin ide anda jempolan-anda dapat
melupakan gagasan mereka.

AAppaakkaahh  ttuujjuuaann  ssiittuuss  aannddaa??
Apakah anda ingin mencetak uang de-
ngan situs anda itu ataukah anda sudah
cukup senang jika situs itu hanya men-
jadi alat penyalur hobi anda? Apakah
anda membangun situs itu untuk
mempromosikan perusahaan anda,
grup band anda, busana produksi peru-
sahaan anda, atau anda hanya ingin
membanggakan koleksi perangko anda
ke seluruh dunia.

Jenis situs pun akan menentukan
server yang bagaimana yang diperlu-
kan—Web hosting gratisan mungkin
sudah cukup memadai untuk situs pe-
nyalur hobi, tetapi jika anda menem-
patkan perusahaan anda di Internet,
anda perlu berinvestasi dengan mem-
beli sebuah nama domain serta me-
nyewa server komersial.

Anda juga perlu mempertimbangkan
persyaratan bandwith-banyak ISP
yang menentukan batasan dan akan
menyetop layanannya bagi anda jika
situs anda menjadi terlalu populer.
Untuk itu, anda harus menceknya pada
ISP langganan anda dan jika perlu
membayar server alternatif.

SSiiaappaakkaahh  kkhhaallaayyaakknnyyaa??
Siapakah yang anda pikir akan menjadi
khalayak sasaran anda dan mengapa
mereka perlu datang ke situs anda?
Apakah untuk topik yang sama sudah
ada situs yang berhasil, dan jika sudah
ada, apa yang membuat orang perlu
mengunjungi situs anda? Tawaran unik
apakah yang dapat anda berikan?

Ada perusahaan yang mempunyai
gagasan bahwa hanya dengan
memajang brosur perusahaannya di
Internet, penjualan mereka akan
meroket. Padahal itu tidak akan terjadi.
Untuk masalah komersial, suatu
strategi Web yang konsisten perlu
dikembangkan dengan sasaran
khalayak yang khusus.

SSiiaappaakkaahh  ppeessaaiinngg  aannddaa??
Tidak ada gunanya anda menghabiskan
waktu berminggu-minggu untuk
membuat situs mengenai keju terlezat
di dunia ini jika sudah ada ratusan
situs serupa yang sudah online. Tetapi
jika keju benar-benar merupakan
produk unggulan anda, lakukan
penelitian terhadap situs pesaing anda
dan coba temukan sesuatu yang belum
disentuh oleh mereka atau carilah
gagasan yang orisinal untuk masalah
itu.

Masukkan kata kunci yang berkaitan
dengan situs yang anda rencanakan
pada mesin pencari dan periksa situs-
situs yang ditemukan. Buat catatan
mengenai apa yang anda sukai dan ti-
dak sukai mengenai situs-situs itu dan
pertimbangkan kemungkinan pening-
katan dari gagasan yang anda temukan
di sana. Apa pun yang anda lakukan,
jangan cuma mencuri gagasan orang
lain karena jika demikian kredibilitas
anda dengan cepat akan menguap.

Jika anda benar-benar serius, ada
baiknya anda mencari tahu apa yang
dikatakan orang lain mengenai pesaing
anda dan belajar dari masukan negatif
mereka—galilah sisi negatif mereka
lewat arsip diskusi Usenet di hhttttpp::////
ggrroouuppss..ggooooggllee..ccoomm. Jangan lupa juga
menggali informasi dari surat kabar
cetak karena sumber yang satu ini pun
dapat menjadi sumber informasi latar
belakang yang kaya.

Apakah Web merupakan medium

yang tepat untuk anda?
Walaupun Web selalu dipuja-puji, be-
lum tentu sarana ini cocok untuk se-
mua orang.

Ada baiknya anda mengkaji tujuan-
tujuan anda untuk mengetahui apakah
Web merupakan jawaban paling tepat
untuk kebutuhan anda. Apakah sudah
ada situs yang sukses luar biasa untuk
topik yang sama di Internet? Apakah
anda dapat menyainginya? Atau lebih
baik darinya?

Jika anda tengah merencanakan situs
perusahaan anda, apakah situs Web
dapat mencerminkan pemanfaatan
terbaik dari sumber daya di perusahaan
anda? Anda akan mudah tergerak
memikirkan prospek untuk mengiklan-
kan produk dan jasa layanan anda di
gelanggang global, tetapi metode ini
malah bisa menimbulkan malapetaka
jika nanti anda malah tidak dapat me-
nangani pesanan ekspor serta semua
beban pekerjaan administratif
tambahannya.

Berikan apa yang mereka inginkan
Jika anda yakin sudah dapat menetap-
kan tujuan situs anda, kini tiba waktu-
nya berkonsentrasi pada pihak yang
paling berkepentingan—khalayak atau
audiens anda. Tetapi siapakah mereka?

Semoga saja anda telah mempunyai
gagasan yang cukup jelas setelah men-
coba menjawab pertanyaan-pertanyaan
di atas, tetapi kini anda perlu melebar-
kannya sehingga dapat mencakup se-
mua kemungkinan yang dapat anda
pikirkan.

Mari kita ambil sebuah contoh. Ba-
yangkan situs anda dirancang untuk
mempromosikan seorang penyanyi
yang cukup berhasil. Siapa yang ke-
mungkinan akan mengaksesnya? Ya,
sudah barang tentu akan ada pengge-
mar sang penyanyi, tetapi lalu bagai-
mana halnya perusahaan rekaman
yang tengah mencari bakat baru, pro-
motor, festival lagu nasional dan inter-
nasional, majalah musik yang meng-
inginkan wawancara, orang yang men-
download MP3, stasiun radio dan lain
sebagainya? Untuk setiap kemungkin-
an pengunjung, pikirkan mengenai
kemungkinan pendapat mereka me-
ngenai situs anda—apakah mereka
dapat menemukan apa yang mereka
inginkan dengan mudah? Apakah me-
reka dapat memperoleh informasi yang
mereka perlukan, dan jika tidak,
mengapa tidak?

Yang juga perlu dipertimbangkan
adalah bagaimana khalayak anda akan
mengakses situs anda. Apakah

• Situs yang telah direncanakan matang lengkap
dengan sub-sub bagiannya yang logis akan mem-
buat anda lebih mudah mengelola serta
memperbaruinya.

Sumber di dunia maya

Sumber terbaik mengenai arsitektur
informasi yang tersedia di Web...

Moock
www.moock.org/webdesign/lectures/
web101/week4.html

CNET Builder.com: What is Information
Architecture?
http://builder.cnet.com/ webbuilding/0-
3881-8-5113200-1.html

ACRL Internet Resources
http://www.ala.org/acrl/resoct00.html

Webmonkey
http://hotwired.lycos.com/webmonkey/de
sign/site_building/tutorials/tutorial1.html

CNET Builder.com: Conceptualize Your Site
www.builder.com/Graphics/Conceptualize
/ss01.html

Making the Net Work: Planning a Web Site
www.makingthenetwork.org/toolbox/tools
/webguide.htm



perusahaan rekaman besar dengan
akses Internet broadband atau
penggemar rumahan dengan modem
28,8? Apakah isi situs anda berisi
materi yang mungkin menarik bagi
pengguna telepon bergerak yang harus
berselancar di Internet lewat koneksi
telepon selular yang alon?

Bagaimana halnya dengan teknologi?
Apakah anda akan memaksa semua
pengunjung untuk menginstal browser
terbaru dan harus men-download sege-
robak plug-in yang dapat membuat
pulsa telepon membengkak sebelum
mereka dapat mengakses situs anda,
atau apakah anda akan membuatnya
bisa diakses oleh seluas mungkin
khalayak?

Pada masing-masing skenario, anda
harus memperoleh gambaran yang
lebih baik mengenai kemungkinan
tuntutan dari pengunjung. Masukan
seperti ini akan bermanfaat untuk
perencanaan rancangan dan fungsi
situs anda.

Isi adalah raja
Sampai di sini anda telah selesai me-
nentukan akan seperti apakah situs
anda dan siapakah yang akan menjadi
khalayaknya. Kini tiba saatnya anda
memberikan apa yang dituntut oleh
para peselancar yang lapar itu

Buat sebuah daftar panjang mengenai
seluruh isi yang anda inginkan di situs
anda—reviu, berita, umpan balik, file
yang bisa di-download, bulletin boards,
apa pun—tetapi dengan pertimbangan
bahwa anda mempunyai sumber daya
untuk memenuhinya. Kebanyakan
orang memulai langkahnya dengan
rencana yang ambisius, jadi bersiap-
siaplah untuk menyingkirkan fitur-
fitur yang kurang esensial dan
fokuskan perhatian pada fungsi inti
situs.

Pertimbangkan teknologi yang
dibutuhkan untuk menyajikan isi situs
anda. Apakah anda benar-benar
membutuhkan basis data dinamis yang
canggih atau cukup dengan halaman
HTML yang statis? Apakah anda
mempunyai tenaga pengelola yang
terampil untuk mengelola basis data
yang dibentuk ataukah lebih praktis
jika melemparkan pekerjaan tersebut
pada layanan di luar perusahaan?

Evaluasi implikasi administratif dari
setiap kemungkinan dan pastikan bah-
wa anda dapat memenuhi janji anda-
sebuah situs Web yang mempunyai
bagian berita tidak akan menarik lagi
jika berita yang disajikan terlambat
empat minggu.

Yang terakhir, berhati-hatilah terhadap
kecenderungan untuk menambahkan
terlalu banyak fitur di situs anda.
‘Penyakit’ ini biasanya menghinggapi
para pengelola situs yang latah ingin
mengikuti trend sehingga situs mereka
tidak lagi fokus, tertutup oleh terlalu
banyaknya hal baru yang tidak
direncanakan sebelumnya.

Membangun struktur
Kini anda sudah mengantungi daftar
panjang mengenai isi situs, jadi tiba
saatnya untuk mendefinisikan struktur
situs yang berarti menata segala
sesuatu ke dalam sub-sub bagian yang
logis dan manageable.

Sub-sub bagian ini harus dapat men-
jelaskan dirinya sendiri (self explanat-
ory). Setiap sub seksi mengandung
sejumlah isi yang mirip sehingga tidak
akan ada kesenjangan yang terlalu jauh
antara sub bagian yang satu dengan
yang lain. Cobalah mengantisipasi
pertumbuhan dan pertimbangkan
bagaimana cara mendistribusikan isi
tambahan di masa depan.

Ingatlah, makin banyak sub bagian
yang anda cemplungkan, maka makin
besar kemungkinan anda menengge-
lamkan pengunjung di antara hala-
man-halaman Web anda. Jadi penge-
lompokan isi dalam sub-sub bagian
harus ramping dan logis.

Anda tidak boleh tergesa-gesa dalam
proses ini karena kesalahan yang di-
buat pada tahap ini bisa menjadi pe-
nyakit yang perlu diobati di kemudian
hari—satu saja sub bagian yang
tertinggal, maka ganjarannya adalah
kerja bergadang bermalam-malam
untuk mengembalikannya ke jalur
yang benar jika situs itu telah
terbentuk.

Satu tip penting—jika anda menjual
produk secara online, pastikan halaman
pemesanan mudah diakses, sebaiknya
hanya satu klik dari halaman pembuka.
Data statistik membuktikan bahwa
makin banyak klik yang harus dilalui
pengunjung untuk sampai pada
halaman pemesanan, maka makin
sedikit pesanan yang akan anda terima.

Buat peta situs
Berdasarkan semua informasi yang
telah terkumpul, anda sudah hampir
siap untuk mulai membangun situs
anda, tetapi sebelum anda dengan
gagah mengotak-atik halaman HTML
anda, sebelumnya anda perlu membuat
pemetaan situs. Lazimnya sebuah peta,
dengan berbekal peta situs anda tidak
akan berjalan ‘ngawur’ dalam
pembuatan situs.

Tampilan adalah segalanya
Setelah selesai menggarap tujuan,
taget, khalayak, struktur dan isi situs,
maka anda telah mengantungi semua
informasi yang diperlukan untuk mu-
lai membangun situs. Tetapi sebelum
anda membuka program editor HTML
anda, masih ada satu pertimbangan
yang tersisa—bagaimana penampilan
situs itu nanti?

Di sinilah penelitian awal anda akan
berperan. Selama tutorial ini anda
sudah mengidentifikasi calon khalayak
anda, meneliti situs sejenis yang
berhasil, dan sudah memperoleh pe-
mahaman yang baik mengenai ran-
cangan dan interface yang bagaimana
yang cocok dengan gaya dan isi situs
anda.

Dengan berbekal semua pengetahuan
ini, anda seharusnya sudah berada di
jalur yang benar untuk mempunyai
situs yang seusai perencanaan dan
yang dirancang dengan baik—semua
itu berkat arsitektur informasi.

NeoBiz
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Kompleks Mahkota Mas Tangerang
Jl. MH Thamrin, Cikokol
Tel. 547 5873/76
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Menyelamatkan BumiMenyelamatkan Bumi
Bersama KBersama KIISSSS
Ikuti kisah petualangan KISS yang berusaha
menyelamatkan bumi dari kehancuran lewat suatu
webisodes bertajuk KKIISSSS  IImmmmoorrttaallss..

ISS Immortals adalah
sebuah kisah petua-
langan animasi 3D

dengan tokoh-tokoh utama
dari dunia nyata yaitu
personel musik rock KISS.

Animasi ini dirancang dan di-
buat oleh Brilliant Digital
Entertainment (wwwwww..ddiiggiittaall--
hhiitt..ccoomm//mmuullttiippaatthh..sshhttmmll)
yang menamakan karyanya
Multipath Movies. Film ani-
masi ini bersifat interaktif.
Anda dapat berpartisipasi dan
ikut menentukan jalan cerita
lewat pilihan-pilihan yang
diajukan di dalam film dan
dapat anda pilih dengan
klikan mouse.

KISS Immortals sendiri diba-
gi dalam beberapa episode

yang dibuat per

minggu dan saat ini sudah
mencapai 27 episode. Jika
anda mendaftarkan alamat
email anda di situs pembuat
film multipath ini, anda akan
mendapat kiriman setiap
episode sejak mulai anda
mendaftar.

Kualitas animasi prima

Brilliant Digital Entertain-
ment dapat dikatakan mem-
buat film animasi yang
prima. Desain grafis yang
cukup halus dengan jalan
cerita yang menarik serta
penokohan yang hidup. Bagi
penggemar KISS, film ini pun
dapat mengobati kerinduan
mereka akan kelompok musik
yang pernah mencapai pun-
cak kejayaannya pada dekade
1970-an itu. Di film yang
dapat anda pirsa gratis di
komputer anda ini, anda akan
dapat menyimak beberapa
lagu hits KISS yang dalam
kisah ini digunakan juga
untuk melawan tirani sang
penguasa yang kejam.

K

SELAIN KISS
IMMORTALS,
Brilliant Digital

juga membuat
webepisodes lain, seperti
Ace Ventura dan Xena.

INFO

NEOTEK

Siapakah KISSiapakah KISS?S?
KISS adalah grup musik cadas
yang memulai debutnya pada
tahun 1970-an. Kekhasan
kelompok ini adalah pada asesoris
pakaian dan make-up wajah yang
mereka kenakan ketika berkonser di
panggung sehingga mereka
mendapat julukan theater-rocker.
Nama KISS mendunia ketika pada
tahun 1975 mereka merilis album
Alive, dengan hit-nya “Rock and
Roll All Nite.”

KISS merajai panggung musik rock
pada tahun 1976-1979 dan menjadi mesin uang
bagi produsernya. Kedigjayaan mereka mulai
redup di penghujung dekade 70an.
Namun mereka mampu bangkit
lagi sampai pada tahun 1998
album mereka Psycho Circus
masih mampu mencetak
mencetak hit.

wwwwww..rroolllliinnggssttoonnee..ccoomm//aarrttiissttss//
bbiioo..aasspp??ooiidd==336655&&ccff==336655
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bukaan tersebut menjulur benda mirip ular yang lalu
merengkuh dan mengangkat keempat personel KISS itu
memasuk labirin kehijau-hijauan yang akhirnya
mengantarkan mereka ke sebuah planet yang melarang
penghuninya bermain musik.

Planet itu bernama Umbra dan diperintah oleh seorang
penguasa kejam bernama Tempest. Dengan jaringan kaki
tangannya yang berdarah dingin, Tempest menekan
penduduk Umbra. Kedatangan KISS, oleh karenanya,
menumbuhkan harapan bagi penduduk untuk
memperoleh kemerdekaannya kembali.

Dibutuhkan komputer dengan spesifikasi tinggi
Game dalam bentuk film animasi ini digarap dengan
apik dari segi grafis maupun ceritanya. Kesulitan yang
mungkin dialami pengguna Internet di Indonesia adalah
untuk memainkannya diperlukan jaringan Internet
broadband karena film ini menggunakan teknologi video
streaming untuk mengirimkan data-data filmnya agar
dapat diputar di komputer anda. Selain itu, diperlukan
juga komputer dengan spesifikasi mesin yang cukup
tinggi, minimal berprosesor Pentium III.

isahnya bermula pada akhir
konser KISS pada Psycho
Circus Tour mereka. Di

akhir konser, tiba-tiba langit-langit
gedung konser terbuka dan dari

BBEERRKKEENALNALAN DAN DEENNGGANAN
MMUULLTTIIPPAATTH GH GAMAMEE
KKIISS ISS IMMMMOORRTTALALSS
Lewat game ini anda dilibatkan untuk ikut menentukan jalan
cerita dengan pilihan-pilihan yang disediakan bagi peserta game.
Tetapi untuk dapat memainkan game ini diperlukan spesifikasi
komputer yang cukup tinggi.

K

Webisodes pertama
Setelah selesai men-download, ‘b3d Projector’ langsung
memutar webisode (episode di web) pertama yang
berjudul ‘Into the Void.’

Awal keterlibatan KISS
Pada webisode ‘Into the Void’ dikisahkan ‘diciduknya’
personel KISS oleh ‘tangan tidak berbentuk’ yang ke-
mudian mendamparkan mereka di Umbria. Anda dapat
ikut serta menentukan jalan cerita pada beberapa
webisode sesuai dengan sifat multipath movies.

‘Sarang’ multipath movies
Kunjungi situs DigitalHit.com (www.digitalhit.com/
multipath.shtml). Di sini anda akan menemukan link
untuk beberapa multipath movies produksi Brilliant
Digital Entertainment yang salah satu di antaranya
adalah “KISS Immortals.”

Layar pembuka film
Klik link berlogo ‘KISS.’ Sebuah window dari channel
Brilliant Digital Webisodes terbuka. Anda diminta
mengisi formulir pendaftaran sebelum dapat memasuki
layar pemutaran film.

1

5 6

2

Webisode lainnya
‘KISS Immortals’ terdiri dari 27 webisode dengan kisah
yang menarik pada setiap webisode-nya. Pilih
webisode yang akan anda pirsa lewat menu seperti
pada gambar di atas.

Akhir cerita
Inilah adegan webisode ‘Comin’ home.’ KISS berhasil
kembali ke bumi, terdampar di panggung yang sama
ketika mereka diciduk dan, dengan alat musik yang
makin powerful, menyanyikan lagu wajib rocker 70-an
yang merupakan hit mereka, ‘Rock and Roll All Nite.’

Apa sih multipath movies itu?
Jika anda ingin penasaran terhadap apa yang
dinamakan multipath movies, silakan klik menu ‘About.’
Sebuah layar yang menjelaskan pengertian multipath
movies muncul. Silakan menyimak penjelasan yang
diberikan.

Men-download ‘b3d Projector’
Untuk menikmati film multipath keluaran Brilliant
Digital ini, anda harus men-download sebuah program
untuk penayang film di komputer anda yang diberi
nama ‘b3d Projector.’

3

7 8

4

Save the Earth
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A.D.A.M. Online Anatomy
A.D.A.M. Online Anatomy sebelum-
nya dikenal dalam bentuk CD ROM.
Hanya untuk dapat mengakses A.D.A.M.
anda sebagai perorangan harus mero-
goh kantong US$19.50 per bulan.

A.D.A.M. Online Anatomy biasanya

digunakan oleh para mahasiswa
biologi atau kedokteran dan akses gra-
tis diperoleh bersama-sama antara do-
sen dan mahasiswa apabila dosen yang
bersangkutan menggunakan buku teks
dari penerbit. Untuk keperluan sekolah
menengah, situs ini cukup memadai.

lat peraga merupakan perang-
kat pengajaran yang cukup
mahal, baik itu untuk peng-

ajaran di SMU seperti kimia dan bio-
logi ataupun SMK seperti alat peraga
otomotif. Apabila pada NeoTek Agus-
tus 2001 telah dibahas Chime 2.6 se-
bagai alat peraga molekul tiga dimensi,
maka kali ini kita akan membahas alat
peraga anatomi dari situs InnerBody:
wwwwww..iinnnneerrbbooddyy..ccoomm

Situs ini terbagi atas dua bagian, yang
kedua-duanya tentang anatomi. Yang
satu adalah anatomi tubuh manusia
dan yang lainnya anatomi otoomotif.
Situs anatomi gratis ini memang kalah
canggih dengan situs komersial.

BBEELLAAJJARAR
ANAANATTOOMMI MANI MANUUSSIAIA
DDAN OAN OTTOOMMOOTTIIFF
DDI II INTENTERRNNEETT
Situs ini telah menjadi pilihan para guru maupun siswa untuk
mempelajari bagian dalam manusia dan mobil. Memadai
sebagai situs gratis, walaupun tidak sebaik A.D.A.M. Online
Anatomy yang harus bayar!

A

Ada juga animasinya 
Kalau anda bosan dengan penje-
lasan biasa, coba klik  Animat-
ions dan frame kanan akan me-
nampilkan Animation Index.
Animasi yang ditampil-kan antara
lain Brakes in Action, Cooling
System, dan V8 Engine.

Animasi mesin v8
Mesin V8 tentupernah anda de-
ngar. Mau tahu cara bergeraknya?
Klik V8 Engine pada frame Ani-
mation Index. Kemudian animasi
dimulai dan penjelasannya di-
tampilkan pada frame di sisi
kanan. 

Situs ini dijual?
Mungkin karena banyaknya pe-
ngunjung situs ini (40.000 pe-
ngunjung setiap bulan), penge-
lolanya berniat untuk menjualnya.
Alasannya sih, mereka ingin fokus
ke proyek lain. Anda berminat? 

Animasi
Mempelajari aliran darah dari/ke
paru-paru dan jantung akan lebih
mudah melalui animasi. Klik tom-
bol Animations untuk menampil-
kan daftar animasi apa saja yang
tersedia pada situs itu. Daftar ini
tampil pada kolom kanan sebagai
Animation Index.

Animasi aliran darah
Pilih Cardiovascular System dari
daftar pada Animation Index dan
animasi ini akan di-load ke layar
anda. Kecepatan animasi dapat
diatur dengan menggeser-geser
tombol geser di bagian bawah
layar animasi ini.

INDEKS
Apabila memerlukan bahan-bahan
pengajaran untuk suatu topik, baik
itu diagram, animasi, ataupun infor-
masi, gunakan fasilitas Search. Fasi-
litas ini mendukung logika Boole
seperti AND, OR, NOT, dan kom-
posisi tanda kurung.

4 5

4 5 6

6

Sepasang situs anatomi: anatomi manusia dan anatomi otomotif

Cara kerja otomotif
Pada Automotive Learning
Online, anda akan belajar
mengenai sistem pengereman,
pendingin, listrik, engine, body
dan exterior, AC/Heat, exhaust,
fuel, steering dan suspension dan
juga drive train. 

Sistem mesin
Engine System terdiri dari
beberapa bagian. Salah satunya
adalah Cylinder Head tebagi
menjadi Left dan Right Cylinder
Head. Jika anda klik salah satunya
maka deskripsinya akan
ditampilkan pada frame kanan.

Ingin lebih rinci?
Jika ingin lebih detail lagi, turun-
kan krusor untuk melihat menu
tambahan di bawahnya. Coba klik
Overhead Cam Cylinder Head
dan akan muncul gambar po-
tongan part-nya  dengan lebih
detail.

Pelbagai sistem
Masuk ke situs InnerBody.com di
www.innerbody.com/htm/body.html
dan akan tampil pelbagai sistem da-
lam tubuh manusia: kerangka, pen-
cernaan, otot, limpa, endokrin, saraf,
kardiovaskular, reproduksi pria, re-
produksi wanita, dan saluran kemih.

Sistem kadriovaskular
Misalkan kita pilih sistem kardiovas-
kular, maka akan tampil diagram
jantung dan pembuluh-pembuluh
darah serta paru-paru. Dengan meng-
klik bagian dari diagram itu, Infor-
masi dari bagian yang ingin dipela-
jari akan tampil di kolom kanan.

Penampang lintang jantung
Pada bagian bawah diagram sis-
tem kardiovaskular terdapat dia-
gram-diagram lain yang berhu-
bungan. Di antaranya adalah pe-
nampang lintang jantung. Bagian-
bagiannya juga dapat dipelajari
dengan mengklik pada bagian
yang akan dipelajari.

1 2

1 2 3
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